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Preface

Cisco TEO automation pack files are a collection of Tidal Enterprise Orchestrator (TEO) processes 
(workflows) authored by subject matter experts that work out-of-the-box to automate best practices for 
a particular technology. The automation pack files also include configuration objects that are used in the 
processes, such as variables, categories, target groups and knowledge base articles.

The Cisco TEO automation packs for Cloud provide the content to support Cloud orchestration. This 
guide provides information on importing and using the following Cloud automation packs that ship with 
TEO:

Automation Pack Name Description

Cloud Common Contains objects shared across all cloud content.

Cloud newScale Service Catalog Contains all processes and objects required to integrate 
newScale Service Catalog with cloud content. 

Cloud Physical Server Automation Contains the infrastructure related processes for creating 
and managing physical machines.

Cloud Virtual Server Automation Contains the infrastructure related processes for creating 
and managing virtual machines.

Cloud Service Orchestration Contains processes for orchestrating fulfillment of cloud 
service requests.
ix
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Organization
This guide includes the following sections:

Chapter 1 Importing Automation Packs Provides instructions for installing the automation 
pack during or after the initial installation of TEO.

Chapter 2 Configuring Cloud Environment Provides instructions for configuring the 
CloudGovernor database, and importing, 
deploying and configure newScale Service 
Catalog.

Chapter 3 Understanding the Automation 
Pack Content

Provides information on the objects included in the 
automation packs.

Chapter 4 Getting Started Using the 
Automation Pack

Provides information on creating the objects for 
using the content in the automation packs (runtime 
user, targets, task rules, extended target properties 
and global variables).

Chapter 5 Managing the Cloud Processes Provides information on using the processes that 
ship with the automation pack.

Chapter 6 Using the Cloud Activities Provides information on defining the activities 
(atomic processes) that ship with the Cloud 
Common automation pack.

Appendix A Cloud Operations Provides information about tasks you may need to 
perform on a daily or less frequent basis for 
efficient cloud operations.
x
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Preface
Conventions
This guide uses the following conventions: 

Note Means reader take note.

Tip Means the following information will help you solve a problem. 

Caution Means reader be careful. In this situation, you might perform an action that could result in equipment 
damage or loss of data.

Timesaver Means the described action saves time. You can save time by performing the action described in 
the paragraph. 

Warning Means reader be warned. In this situation, you might perform an action that could result in 
bodily injury.

Convention Indication

bold font Commands and keywords and user-entered text appear in bold font.

italic font Document titles, new or emphasized terms, and arguments for which you supply 
values are in italic font.

[   ] Elements in square brackets are optional.

{x | y | z } Required alternative keywords are grouped in braces and separated by 
vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in brackets and separated by 
vertical bars.

string A nonquoted set of characters. Do not use quotation marks around the string or 
the string will include the quotation marks.

courier font Terminal sessions and information the system displays appear in courier font.

<   > Nonprinting characters such as passwords are in angle brackets.

[   ] Default responses to system prompts are in square brackets.

!, # An exclamation point (!) or a pound sign (#) at the beginning of a line of code 
indicates a comment line.
xi
Cisco TEO—Process Automation Guide for Cloud

OL-25276-01



 

Preface
  
Product Documentation

Documentation Formats
Documentation is provided in the following electronic formats:

 • Adobe® Acrobat® PDF files

 • Online help

You must have Adobe® Reader® installed to read the PDF files. Adobe Reader installation programs 
for common operating systems are available for free download from the Adobe Web site at 
www.adobe.com.

Guides and Release Notes
You can download the product documentation in PDF format from the product CD. 

Online Help
Online help is available and can be accessed using the following methods:

 • Click the Help button on any dialog box box in the application to open the help topic in a pane to 
the right of the dialog box box.

 • In the Tidal Enterprise Orchestrator console:

 – Click the Help Pane  tool on the toolbar to open the help topic in a pane to the right of the 
console results pane.

 – Click Help on the menu bar.

Open Source License Acknowledgements
Licenses and notices for open source software used in Tidal Enterprise Orchestrator v2.2 can be found 
in the Open Source Licensing Acknowledgements document on the product CD. If you have any 
questions about the open source contained in this product, please email 
external-opensource-requests@cisco.com.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a RSS feed and set content to be delivered 
directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently 
supports RSS Version 2.0.
xii
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C H A P T E R 1

Importing Automation Packs

The Tidal Enterprise Orchestrator Installation and Administration Guide provides instructions for 
installing Tidal Enterprise Orchestrator (TEO) and the core components. During the initial installation 
of TEO, you can choose to import the automation packs, or import them later from within the Console. 

This chapter guides you through importing the Cloud automation packs. It includes the following 
sections:

 • Prerequisites, page 1-2

 • Accessing the Automation Pack Import Wizard, page 1-3

 • Importing the Cloud Common.tap, page 1-5

 • Importing the Cloud newScale Service Catalog.tap, page 1-10

 • Importing the Common Activities.tap, page 1-13

 • Importing the Cloud Physical Server Automation.tap, page 1-15

 • Importing the Cloud Virtual Server Automation.tap, page 1-17

 • Importing the Cloud Orchestration.tap, page 1-20

Note It is recommended that you review the system requirements and prerequisites for TEO before importing 
automation packs. See the Tidal Enterprise Orchestrator Installation and Administration Guide. 
 
You must also have your cloud environment installed and configured prior to importing the automation 
packs. See Prerequisites.
1-1
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Prerequisites
Prior to importing the Cloud automation packs and configuring the TEO cloud content, it is 
recommended that you have the following servers installed and configured.

Table 1-1 Cloud Content Prerequisites

Server Quantity Description

Tidal Enterprise Orchestrator 1 or more In a multiple TEO server environment one server 
will serve as the request manager. The request 
manager will receive all requests from newScale 
and route it to the appropriate TEO server for 
processing. Each newScale request includes the 
organizational unit (OU) to which the request 
belongs. The OU is used to determine which TEO 
server will own the request.

In a single TEO server environmnent, the request 
manager will route the request to itself.

newScale RequestCenter 1 A web-based self-service portal for requesting 
services.

VMware vCenter (required 
for virtual provisioning)

1 or more Each newScale request includes the organizational 
unit (OU) to which the request belongs. The OU is 
used to determine which vCenter server will own 
the virtual server.

Cisco UCS Manager

(required for physical 
provisioning)

1 or more Each newScale request includes the organizational 
unit (OU) to which the request belongs. The OU is 
used to determine which UCS Manager server will 
own the physical server.

Microsoft SQL Server 1 Used to host the Cloud Governor database. It can be 
shared with the TEO server database.

Tidal Server Provisioner 1 Used for bare metal provisioning.
1-2
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Chapter 1      Importing Automation Packs
  Accessing the Automation Pack Import Wizard
Accessing the Automation Pack Import Wizard
You use the Automation Pack Import Wizard to import the automation packs (tap files). You can either 
open the wizard immediately after installing TEO or from within the Console.

Opening the Import Wizard After Running Setup Wizard

Step 1 After running the Setup wizard to install the product, ensure that the Launch automation pack import 
wizard now check box is checked before closing the wizard.

The Select Automation Packs dialog box displays the available automation packs. All automation packs 
are checked by default.

Step 2 Ensure that the following check boxes are checked and then click OK to launch the Automation Pack 
Import Wizard:

 • Core (checked by default)

 • Common Activities (dependency)

 • Cloud Common

 • Cloud newScale Service Catalog

 • Cloud Physical Server Automation

 • Cloud Virtual Server Automation

 • Cloud Service Orchestration

Note See the Tidal Enterprise Orchestrator Installation and Administration Guide for instructions on 
importing and configuring the Core components for the product.

Proceed to Importing the Cloud Common.tap, page 1-5.
1-3
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Opening the Import Wizard from Console
You can open the Automation Pack Import Wizard from within the Console after installing the product. 
When importing automation packs from within the Console, you must re-open the Automation Pack 
Import Wizard for each automation pack that you are importing. 

Because the Cloud automation packs have a dependency on the Common Cloud automation pack, you 
must import this automation pack first. 

Step 1 In the Administration workspace on the Console, click Automation Packs in the navigation pane.

Figure 1-1 Automation Packs View—Import Menu

Step 2 Use one of the following methods to open the Automation Pack Import Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 3 On the Windows Open dialog box, select the Cloud Common.tap file and click Open to launch the 
Automation Pack Import Wizard. 

Proceed to Importing the Cloud Common.tap, page 1-5.
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  Importing the Cloud Common.tap
Importing the Cloud Common.tap
The Cloud Common automation pack imports the content that is shared by all Cisco Cloud automation 
packs. During the import, the following tasks are performed:

 • Creates a web target for the local TEO server

 • Extracts the SQL script for creating the Cloud Governor Database

 • Configures the TEO task rule for cloud incident default assignments

The Automation Pack Import Wizard guides you through importing the automation packs. If you opened 
the Automation Pack Import Wizard from the Setup Completed panel, the wizard will guide you through 
importing each automation pack.

Step 1 On the Welcome panel, click Next.

Figure 1-2 Welcome to the Automation Pack Import Wizard

Note If you do not want to display the Welcome panel the next time the wizard is opened, check the 
Do not show this page next time check box.
1-5
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  Importing the Cloud Common.tap
Figure 1-3 General Information—Cloud Common

Step 2 On the General Information panel, review the information about the automation pack.

Note If you launched the Automation Pack Import Wizard from the Console, you can disable all the 
imported processes during the import process by checking the Disable all imported processes 
check box. If you disable all the imported processes, you will need to manually enable the 
processes in the Console before they can execute. See Enabling a Process, page 5-4. 
 
This check box does not display if you launched the wizard from Setup.

Step 3 Click Next to continue.

Figure 1-4 Data Extraction—Cloud Common

Use the Data Extraction panel to specify the destination where the Cloud Governor Database Scripts will 
be extracted. These scripts are used to create the Cloud Governer database.
1-6
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  Importing the Cloud Common.tap
Step 4 On the Data Extraction panel, accept the default location or click the Browse  tool to specify a new 
destination.

Step 5 In the Select data extract area, verify that the check box is checked for the data to be extracted.

Step 6 Click Next.

Figure 1-5 Default Incidents Assignee Setup—Cloud Common

Use the Default Incidents Assignee Setup panel to specify the default person who should be assigned 
Cloud-related incidents.

Step 7 Click the Browse  tool to specify the user.

Figure 1-6 Select User or Group

Step 8 On the Select User or Group dialog box, click Location and choose the location from which the user 
will be selected.

Step 9 In the text box, enter the user name and click Check Names.

If the name is found, the box will be populated with the appropriate email address.

Step 10 Click OK to close the Select User or Group dialog box.

Step 11 On the Default Incidents Assignee Setup panel, click Next.
1-7
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  Importing the Cloud Common.tap
Figure 1-7 Tidal Enteprise Orchestrator Web Service—Cloud Common

Step 12 Check the check box for the type of web service that will be used to connect to the TEO web service 
target:

Step 13 Click Next.

Field Description

Enable secure Web Service (HTTPS) Check this check box to configure the authentication 
for the HTTP endpoints and then specify the port and 
authentication mechanism.

Enable non-secure Web Service (HTTP) Check this check box to unencrypt the HTTP endpoints 
and then specify the port and authentication 
mechanism.

Note For Cloud content, non-secure Web Service 
(HTTP) and Basic authentication is required.

HTTPS or HTTP Port Enter or verify the port for the TEO web target.

HTTPS or HTTP authentication mechanism Choose the appropriate authentication for the web 
service:

 • Basic—Standard method for providing a user name 
and password to the authentication mechanism

 • Digest—Requires parties that seek to authenticate 
to provide their knowledge of secret keys.

 • Ntlm—Authentication protocol used on networks 
that include systems running the Windows 
operating system and on stand-alone systems.
1-8
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  Importing the Cloud Common.tap
Figure 1-8 Default Web Service Credentials—Cloud Common

Step 14 Use this panel to specify the credentials for connecting to the TEO web service target:

Step 15 Click Next.

Figure 1-9 Review Prerequisites—Cloud Common

Field Description

Domain Enter the domain name assigned to the user account that is 
used to connect to the TEO web service target.

User name Enter the user name for the user account that is used to 
connect to the TEO web service target.

Password Enter the user account password for the user account that 
is used to connect to the TEO web service target.
1-9
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Chapter 1      Importing Automation Packs
  Importing the Cloud newScale Service Catalog.tap
The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The 
green check mark indicates that the prerequisite was found on the computer. 

The red X indicates that the prerequisite was not found on the computer. When this occurs, the import 
process is stopped and cannot continue until all prerequisites have been met. 

If all prerequisites are passed, the wizard automatically continues to the next panel.

Note If you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard 
displays the General Information panel (Figure 1-11 on page 1-11) for the next automation pack.

Step 16 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to close the wizard.

Importing the Cloud newScale Service Catalog.tap
If you are importing the automation packs from within the Console, you must re-open the Automation 
Pack Import Wizard to import the Cloud newScale Service Catalog automation pack. 

Step 1 Use one of the following methods to open the Import Automation Pack Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 2 On the Windows Open dialog box, select the Cloud newScale Service Catalog.tap file and click Open 
to launch the Automation Pack Import Wizard.

Figure 1-10 Welcome to the Automation Pack Import Wizard

Note If you do not want to display the Welcome panel the next time the wizard is opened, check the 
Do not show this page next time check box.
1-10
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Chapter 1      Importing Automation Packs
  Importing the Cloud newScale Service Catalog.tap
Step 3 On the Welcome panel, click Next.

Figure 1-11 General Information—Cloud newScale Service Catalog

Step 4 On the General Information panel, review the information about the automation pack.

Note If you launched the Automation Pack Import Wizard from the Console, you can disable all the 
imported processes during the import process by checking the Disable all imported processes 
check box. If you disable all the imported processes, you will need to manually enable the 
processes in the Console before they can execute. See Enabling a Process, page 5-4. 
 
This check box does not display if you launched the wizard from Setup.

Step 5 Click Next to continue.

Figure 1-12 Data Extraction—Cloud newScale Service Catalog
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  Importing the Cloud newScale Service Catalog.tap
Use the Data Extraction panel to specify the destination where the newScale Service Catalog will be 
extracted.

Figure 1-13 Review Prerequisites—Cloud newScale Service Catalog

The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The 
green check mark indicates that the prerequisite was found on the computer. 

The red X indicates that the prerequisite was not found on the computer. When this occurs, the import 
process is stopped and cannot continue until all prerequisites have been met. 

If all prerequisites are passed, the wizard automatically continues to the next panel.

Note If you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard 
displays the General Information panel (Figure 1-15 on page 1-14) for the next automation pack.

Step 6 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to close the wizard.
1-12
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Importing the Common Activities.tap
If you are importing the automation packs from within the Console, you must re-open the Automation 
Pack Import Wizard to import the Common Activities automation pack.

Note This automation pack must be installed prior to installing the Cloud Physical Server Automation 
automation pack.

Step 1 Use one of the following methods to open the Import Automation Pack Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 2 On the Windows Open dialog box, select the Common Activities.tap file and click Open to launch the 
Automation Pack Import Wizard.

Figure 1-14 Welcome to the Automation Pack Import Wizard

Note If you do not want to display the Welcome panel the next time the wizard is opened, check the 
Do not show this page next time check box.

Step 3 On the Welcome panel, click Next.
1-13
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  Importing the Common Activities.tap
Figure 1-15 General Information—Common Activities

Step 4 On the General Information panel, review the information about the automation pack.

Note If you launched the Automation Pack Import Wizard from the Console, you can disable all the 
imported processes during the import process by checking the Disable all imported processes 
check box. If you disable all the imported processes, you will need to manually enable the 
processes in the Console before they can execute. See Enabling a Process, page 5-4. 
 
This check box does not display if you launched the wizard from Setup.

Step 5 Click Next to continue.

Figure 1-16 Review Prerequisites—Common Activities

The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The 
green check mark indicates that the prerequisite was found on the computer. 
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The red X indicates that the prerequisite was not found on the computer. When this occurs, the import 
process is stopped and cannot continue until all prerequisites have been met. 

If all prerequisites are passed, the wizard automatically continues to the next panel.

Note If you opened the Automation Pack Import Wizard from the Setup Completed panel, the wizard 
displays the General Information panel (Figure 1-18 on page 1-16) for the Microsoft Windows 
Server automation pack.

Step 6 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to close the wizard.

Importing the Cloud Physical Server Automation.tap
If you are importing the automation packs from within the Console, you must re-open the Automation 
Pack Import Wizard to import the Cloud Physical Server Automation automation pack. 

Step 1 Use one of the following methods to open the Import Automation Pack Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 2 On the Windows Open dialog box, select the Cloud Physical Server Automation.tap file and click 
Open to launch the Automation Pack Import Wizard.

Figure 1-17 Welcome to the Automation Pack Import Wizard

Note If you do not want to display the Welcome panel the next time the wizard is opened, check the 
Do not show this page next time check box.

Step 3 On the Welcome panel, click Next.
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Figure 1-18 General Information—Cloud Physical Server Automation

Step 4 On the General Information panel, review the information about the automation pack.

Note If you launched the Automation Pack Import Wizard from the Console, you can disable all the 
imported processes during the import process by checking the Disable all imported processes 
check box. If you disable all the imported processes, you will need to manually enable the 
processes in the Console before they can execute. See Enabling a Process, page 5-4. 
 
This check box does not display if you launched the wizard from Setup.

Step 5 Click Next to continue.

Figure 1-19 Review Prerequisites—Cloud Physical Server Automation

The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The 
green check mark indicates that the prerequisite was found on the computer. 
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The red X indicates that the prerequisite was not found on the computer. When this occurs, the import 
process is stopped and cannot continue until all prerequisites have been met. 

If all prerequisites are passed, the wizard automatically continues to the next panel.

Step 6 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to close the wizard.

Importing the Cloud Virtual Server Automation.tap
If you are importing the automation packs from within the Console, you must re-open the Automation 
Pack Import Wizard to import the Cloud Virtual Server Automation automation pack. 

Step 1 Use one of the following methods to open the Import Automation Pack Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 2 On the Windows Open dialog box, select the Cloud Virtual Server Automation.tap file and click 
Open to launch the Automation Pack Import Wizard.

Figure 1-20 Welcome to the Automation Pack Import Wizard

Note If you do not want to display the Welcome panel the next time the wizard is opened, check the 
Do not show this page next time check box.

Step 3 On the Welcome panel, click Next.
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Figure 1-21 General Information—Cloud Virtual Server Automation

Step 4 On the General Information panel, review the information about the automation pack.

Note If you launched the Automation Pack Import Wizard from the Console, you can disable all the 
imported processes during the import process by checking the Disable all imported processes 
check box. If you disable all the imported processes, you will need to manually enable the 
processes in the Console before they can execute. See Enabling a Process, page 5-4. 
 
This check box does not display if you launched the wizard from Setup.

Step 5 Click Next to continue.

Figure 1-22 VMware Keystore Password—Cloud Virtual Server Automation

Step 6 Enter a password to be used to access the VMware keystore and then click Next.
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Figure 1-23 Review Prerequisites—Cloud Virtual Server Automation

The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The 
green check mark indicates that the prerequisite was found on the computer. 

The red X indicates that the prerequisite was not found on the computer. When this occurs, the import 
process is stopped and cannot continue until all prerequisites have been met. 

If all prerequisites are passed, the wizard automatically continues to the next panel.

Step 7 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to close the wizard.
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Importing the Cloud Orchestration.tap
If you are importing the automation packs from within the Console, you must re-open the Automation 
Pack Import Wizard to import the Cloud Orchestration automation pack. 

Step 1 Use one of the following methods to open the Import Automation Pack Wizard:

 • In the navigation pane, right-click Automation Packs and choose Import.

 • On the Menu bar, choose Actions > Import.

Step 2 On the Windows Open dialog box, select the Cloud Orchestration.tap file and click Open to launch 
the Automation Pack Import Wizard.

Figure 1-24 Welcome to the Automation Pack Import Wizard

Note If you do not want to display the Welcome panel the next time the wizard is opened, check the 
Do not show this page next time check box.

Step 3 On the Welcome panel, click Next.
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Figure 1-25 General Information—Cloud Orchestration

Step 4 On the General Information panel, review the information about the automation pack.

Note If you launched the Automation Pack Import Wizard from the Console, you can disable all the 
imported processes during the import process by checking the Disable all imported processes 
check box. If you disable all the imported processes, you will need to manually enable the 
processes in the Console before they can execute. See Enabling a Process, page 5-4. 
 
This check box does not display if you launched the wizard from Setup.

Step 5 Click Next to continue.

Figure 1-26 Review Prerequisites—Cloud Orchestration

The Review Prerequisites panel displays the prerequisites for the automation pack being imported. The 
green check mark indicates that the prerequisite was found on the computer. 
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The red X indicates that the prerequisite was not found on the computer. When this occurs, the import 
process is stopped and cannot continue until all prerequisites have been met. 

If all prerequisites are passed, the wizard automatically continues to the next panel.

Figure 1-27 Completing the Automation Pack Import Wizard

Step 6 After the objects have been imported, review the information on the Completing the Automation Pack 
Import Wizard panel to verify that it is correct and then click Close to close the wizard.
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Refreshing Web Service
After importing the automation packs, you must refresh the TEO Web Service.

Step 1 In the TEO Console, click File > Server Properties to open the Server Properties dialog box.

Figure 1-28 Server Properties Dialog Box–Web Service Tab

Step 2 Click the Web Service tab and then click Refresh Web Service.

Step 3 Click OK to close the dialog box.

Note You must now configure your cloud environment, including creating the Cloud Governor Database and 
importing the newScale Service Catalog. Proceed to Chapter 2, “Configuring Cloud Environment.”
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Configuring Cloud Environment

After importing the automation packs, you must create and configure the Cloud Governor Database, and 
import and deploy the newScale Service Catalog.

The Cloud Governor Database is used to manage the resources in the cloud and how they are used by 
organizations. When you import the Cloud Common automation pack, the script files necessary for 
creating the database are extracted to the TEO server.

You must also configure newScale Service Catalog to communicate with TEO. This includes importing 
the newScale XML files that are extracted during the automation pack import process and deploying in 
newScale Service Catalog.

This chapter guides you configuring your cloud environment to communicate with TEO. It includes the 
following sections:

 • Creating Cloud Governor Database, page 2-2

 • Configuring newScale Service Catalog, page 2-3

 • Initializing Your Cloud Environment, page 2-10

 • Initiating Service Requests, page 2-12
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Creating Cloud Governor Database
This section guides you through creating the Cloud Governor Database. It is recommended that you 
create the Cloud Governor Database on the same SQL server that hosts the TEO databases.

Step 1 Navigate to the folder on the TEO server where the Cloud Governor Database script files were extracted. 
The default location is:

C:\Users\username\Documents\Cisco\Tidal Enterprise Orchestrator\Extracted Data\Cloud Governor 
Database Scripts

Step 2 Right-click the CloudGovernor-CreateDB file and choose Open With > Notepad.

Step 3 Select all the contents of the file (Ctrl+A), right-click and choose Copy.

Step 4 In Microsoft SQL Server Management Studio, click New Query.

Step 5 On the query canvas, right-click and choose Paste.

Note By default, the database files are created in the following location: 
 
C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL\DATA 
 
If the path to your database and files is different, modify the default path and file size for the 
data file and log files to prevent the script from failing.

Step 6 Click Execute on the toolbar to create the CloudGovernor database.
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Configuring newScale Service Catalog
You must configure newScale Service Catalog to communicate with TEO. This includes importing and 
deploying the newScale Service Catalog files that ship with the Cloud newScale Service Catalog 
automation pack, and then configuring the URL in the agent outbound parameter.

Copying Extracted Files
During the automation pack import process, the following files are extracted to the local drive that was 
specified in the Data Extraction panel. You can copy these files to your local drive on the server where 
newScale Service Catalog resides or browse to them from within newScale Service Catalog.

Step 1 Navigate to the location where the files were extracted during the automation pack import process. By 
default, the files are copied to the following location on the TEO server:

C:\Users\[username]\Documents\Cisco\Tidal Enterprise Orchestrator\Extracted Data\newScale Service 
Catalog

Step 2 Copy the the following files to a folder on the local drive where newScale is installed:

 • TCO-Foundation.xml

 • TCO-Services-Part1.xml

 • TCO-Services-Part2.xml

Optionally, you can browse to the newScale server from the TEO server and select the files.
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Importing Files in newScale Service Catalog
Perform the following procedure to import and deploy the files in newScale.

Step 1 Open newScale in your browser (Internet Explorer).

Figure 2-1 newScale Login

Step 2 In the Returning User login pane, enter your User name and Password in the text fields and then click 
Login.

Note You must log in to newScale as an Administrator.

Step 3 On the newScale Home page, select CatalogDeployer in the module drop-down list.
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Figure 2-2 Opening the CatalogDeployer Module

Step 4 On the CatalogDeployer screen, click New and choose Import from the drop-down list.

Figure 2-3 CatalogDeployer—New Import Menu

Step 5 On the Import Package from File dialog box, click Browse and navigate to the folder where you saved 
the files that were extracted from the automation pack.

Step 6 Select the TCO-Foundation.xml file and click Import.

Step 7 On the Package Import dialog box, when the message Package Imported Successfully displays, click OK.

The Deployment Packages screen displays the package that was imported.
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Figure 2-4 CatalogDeployer—Imported Package

Step 8 Click Deploy to deploy the package.

Step 9 On the Confirm Deploy dialog box, click Deploy Now.

Step 10 When the message Package Deployed Successfully displays on the Deploy Package dialog box, click 
OK.

Step 11 Repeat Step 4 through Step 10 to import and deploy the TCO-Services-Part1.xml file.

Step 12 Repeat Step 4 through Step 10 to import and deploy the TCO-Services-Part2.xml file.
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Configuring newScale Agent Outbound Parameters
You must now configure the newScale agent outbound parameters to communicate with the TEO server. 
Perform the following procedure to configure the agent.

Step 1 Open newScale in your browser and login to the application.

Step 2 On the newScale Home page, select ServiceLink in the module drop-down list.

Figure 2-5 Opening the ServiceLink Module

Step 3 On the ServiceLink screen, click the Manage Integrations tab.

Figure 2-6 ServiceLink—Manage Integrations
2-7
Cisco TEO—Process Automation Guide for Cloud

OL-25276-01



 

Chapter 2      Configuring Cloud Environment
  Configuring newScale Service Catalog
Step 4 On the Agents tab, expand the Agents > TCO Agent folders in the navigation pane and click Outbound 
Properties.

Figure 2-7 Agents—Configure Outbound Properties

Step 5 In the Configure Outbound Properties pane, modify the Value for each of the following properties:

Step 6 Click Save.

Step 7 On the Agents tab, expand the Agents > TCO TSP Agent folders in the navigation pane and click 
Outbound Properties.

Property Name Value

HTTPOutboundAdapter.WsdlURL http://[domain_name]:61527/process?wsdl

Where: [domain_name] is the domain name of the TEO 
server.

HTTPOutboundAdapter.RoutingURL http://[domain_name]:61527/Process

Where: [domain_name] is the domain name or IP address 
of the TEO server.

HTTPOutboundAdapter.UserName UserName

Where: [UserName] is the user name used to connect to the 
TEO server.

HTTPOutboundAdapter.Password Password

Where: [Password] is the password used to connect to the 
TEO server.

HTTPOutboundAdapter.Host Host

Where: [Host] is the host name of the TEO server.

HTTPOutboundAdapter.Domain Domain

Where: [Domain] is the domain name or IP address of the 
TEO server.
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Step 8 In the Configure Outbound Properties pane, modify the Value for each of the following properties:

Step 9 Click Save.

Step 10 Click the Control Agents tab to restart the agents.

Step 11 Select TCO Agent and TCO TSP Agent in the list and then click Start Selected to complete the 
procedure.

Property Name Value

HTTPOutboundAdapter.WsdlURL http://[domain_name]:61527/process?wsdl

Where: [domain_name] is the domain name of the TEO 
server.

HTTPOutboundAdapter.RoutingURL http://[domain_name]:61527/Process

Where: [domain_name] is the domain name or IP address 
of the TEO server.

HTTPOutboundAdapter.UserName UserName

Where: [UserName] is the user name used to connect to the 
TEO server.

HTTPOutboundAdapter.Password Password

Where: [Password] is the password used to connect to the 
TEO server.

HTTPOutboundAdapter.Host Host

Where: [Host] is the host name of the TEO server.

HTTPOutboundAdapter.Domain Domain

Where: [Domain] is the domain name or IP address of the 
TEO server.
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Initializing Your Cloud Environment
Before you can begin using your cloud environment you must first initialize the environment with data. 
This section provides information on the tasks that must be performed to initialize the environment.

Note For additional information on each task, see Appendix A, “Cloud Operations.” 

Defining Organizations
The organizations in your cloud environment must be defined in newScale and pushed to the Cloud 
Governor prior to using the processes to request a service. Organizations can represent departments, 
business units, locations or groups. The cloud resources will be allocated and assigned based on 
organizations so these must be planned very carefully.

Perform the following tasks to define your organizations:

 • In newScale, choose OrganizationDesigner from the module drop-down list, and then click Create 
Organizational Unit to create one or more organizations.

 • After you have created the organization(s), click the Home tab on the OrganizationDesigner 
workspace, and then click Create Person to add the user names for the people who have permission 
to enter a service request.

 • Push the new organization to the Cloud Governor using the “Organization – Onboard” process. 

In TEO, navigate to the Processes view, filter by the Cloud Governor Operations category, and 
then run the “Organization – Onboard” process.

Note You must have a Cloud Governor Database target defined prior to running any processes. See 
Creating Cloud Governor Database Target, page 4-17 for information on creating targets.

Allocating IP Address Pools
You must allocate one or more public and management IP address pools for each defined organization.

In TEO, navigate to the Processes view, filter by the Cloud Governor Operations category, and then 
run the following processes:

 • IP Address Pool – Allocate Public

 • IP Address Pool – Allocate Management
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Defining VMware Templates
Before you can create virtual servers, you must define one or more VMware templates to be used for 
cloning new virtual servers.  The templates need to be pre-built and configured within VMware vCenter.

 • In newScale, use the Manage Standards option in Service Item Manager to add the template to 
newScale.  Add one of the following templates to the standards table depending on the type of 
template to be used:

 – TCO VM Application Server

 – TCO VM DB Server

 – TCO VM Web Server

 • In TEO, navigate to the Processes view, filter by the Cloud Governor Operations category, and 
then run the “VM Template – Add” to add the template to Cloud Governor.

Defining TSP Templates
Before you can bare metal provision servers, you must define one or more Tidal Server Provisioner 
(TSP) templates in Cloud Governor.

In TEO, navigate to the Processes view, filter by the Cloud Governor Operations category, and then 
run the “TSP Template – Add” to add the template to Cloud Governor.

Defining Cisco UCS Blades
You must identify one or more Cisco UCS blades to be used for physical server provisioning.

In TEO, navigate to the Processes view, filter by the Cloud Governor Operations category, and then 
run the “Physical Server – Add” to add the physical server to Cloud Governor as available for use.

Using the Cloud Governor Report
You can execute the Cloud Governor Report process in the Cloud Governor Operations category to 
review cloud governor configuration or to locate values required as input to cloud governor processes.  
The cloud governor report is also schedule to be created daily at 6:00 am.
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Initiating Service Requests
Once the cloud environment is initialized, users can begin submitting requests for new services, such as 
virtual and physical servers. This section guides you through submitting a service request and viewing 
the status of the request.

Submitting a Service Request

Step 1 In newScale, choose MyServices from the module drop-down list.

Step 2 On the MyServices Home page, click the category for the service you want to order.

Figure 2-8 MyServices Home Page

Step 3 Select the service to review an overview of the service, and then click Proceed to Order.

Step 4 Complete the order form and then click Submit Order.
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Viewing Service Request Status
You can view the status of your request or view past requests using the Requisitions page.

Step 1 In newScale, choose MyServices from the module drop-down list.

Step 2 On the MyServices Home page, click the Requisitions tab.

Figure 2-9 MyServices—Requisitions Tab

Step 3 Click Select View to open the dialog box.

Step 4 From the Select Status drop-down list, choose All to view all requests and then click OK.

Step 5 Click the Requisition ID to view details about the request.
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Understanding the Automation Pack Content

The Cloud automation packs include the content used to automate tasks for the cloud orchestration 
framework. This chapter provides information about the content included in the Cloud automation packs. 
It contains the following sections:

 • Accessing Automation Pack Properties, page 3-2

 • Viewing Automation Pack Content and Dependencies, page 3-3

 • Cloud Common TAP Content, page 3-7

 • Cloud newScale Service Catalog TAP Content, page 3-13

 • Cloud Physical Server Automation TAP Content, page 3-14

 • Cloud Virtual Server Automation TAP Content, page 3-15

 • Cloud Service Orchestration TAP Content, page 3-16
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Accessing Automation Pack Properties
Users can access the automation pack properties from the Administration—Automation Packs view in 
the console. The automation pack properties dialog box displays general information about the content 
provided by the automation pack, version number, publish date, list of content (objects) provided, the 
dependencies of the automation pack, and the history of changes made to the automation pack.

Step 1 On the Administration workspace, click Automation Packs in the navigation pane to display the 
installed automation packs in the Automation Packs pane.

Figure 3-1 Accessing Automation Packs

Information about the automation packs display in the following columns:

Step 2 Select the automation pack in the Automation Packs pane, right-click and choose Properties.

Column Description

Company Name Name of the company that released the automation 
pack.

Publish Date Date the automation pack was created or exported to a 
file.

Version Version number of the automation pack.

Display Name Name of the automation pack.

ID Identification number of the automation pack.

Import Date Date the automation pack was imported into the 
product.

Licensed Indicates whether the automation is a licensed product 
in TEO.

Description Text description of the automation pack.
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Step 3 On the Properties dialog box, select the appropriate tab to view the automation pack properties:

Step 4 Click Close to close the dialog box.

Viewing Automation Pack Content and Dependencies
Use the automation pack Properties dialog box to view the content (objects) included in the automation 
pack and the dependencies associated with the automation pack.

Viewing Automation Pack Content
Use the Objects tab to view a list of the content provided by the automation pack.

Step 1 On the Administration—Automation Packs view, select [Automation Pack Name], right-click and 
choose Properties.

Step 2 On the Automation Pack Properties dialog box, click the Objects tab.

Figure 3-2 Cloud Common Properties—Objects Tab

Tab Description

General Displays general information about the automation pack.

Objects Display a list of objects contained in the automation pack.

Dependencies Display a list of automation packs and adapters referenced 
by the objects in the automation pack.

History Displays when the automation pack was created or 
modified, and audit log entries that are relevant to the 
automation pack.
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Step 3 On the Objects tab, review the information about the objects provided by the automation pack.

Step 4 Click Close to close the dialog box.

Viewing Automation Pack Dependencies
Use the Dependencies tab to view the automation packs and adapters referenced by the objects in the 
automation pack. These object must be installed prior to importing the automation pack.

Step 1 On the Administration—Automation Packs view, select [Automation Pack Name], right-click and 
choose Properties.

Step 2 On the Automation Pack Properties dialog box, click the Dependencies tab.

Figure 3-3 Cloud Common Properties—Dependencies Tab

Columns Description

Display Name Name of the object (processes, global variables, 
knowledge base).

Type Object type.

Action Required Action required to successfully import or export the 
objects.

Description Text description of the object.

Version Object version.

Customization Setting Non-default value set to the object. If the column is 
blank, the object has the default setting.
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Step 3 Review the list of automation packs and adapters referenced by the Cloud Common automation pack:

Step 4 Click Close to close the dialog box.

Cloud Automation Pack Dependencies

The following table provides a lit of the dependent automation packs and adapters requried for each 
Cloud automation pack.

Object Type Dependency

Automation Packs  • Core

Adapters  • Core Functions Adapter

 • Microsoft Windows Server Database Adapter

 • Microsoft Windows Server Adapter

 • Web Service Adapter

 • VMware Adapter

Cloud Automation Pack
Dependent Automation 
Packs Required Adapters

Cloud Common  • Core  • Core Functions Adapter

 • Microsoft Windows Server 
Database Adapter

 • Microsoft Windows Server 
Adapter

 • Web Service Adapter

 • VMware Adapter

Cloud newScale Service Catalog  • Cloud Common  • Core Functions Adapter

 • Microsoft SQL Server Database 
Adapter

 • Web Service Adapter

Cloud Physical Server 
Automation

 • Common Activities

 • Cloud Common

 • Core Functions Adapter

 • Cisco UCS Software Adapter

 • Microsoft SQL Server Database 
Adapter

 • Microsoft Windows Adapter

 • Tidal Server Provisioner Adapter
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Cloud Virtual Server Automation  • Cloud Common  • Core Functions Adapter

 • VMware Adapter

 • Microsoft SQL Server Database 
Adapter

 • Microsoft Windows Adapter

 • Tidal Server Provisioner Adapter

Cloud Service Orchestration  • Cloud Virtual Server 
Automation

 • Cloud Common

 • Cloud Physical 
Server Automation

 • Core Functions Adapter

 • VMware Adapter

 • Microsoft SQL Server Database 
Adapter

 • Microsoft Windows Adapter

 • Tidal Server Provisioner Adapter

 • Web Service Adapter

 • Cisco UCS Software Adapter

Cloud Automation Pack
Dependent Automation 
Packs Required Adapters
3-6
Cisco TEO—Process Automation Guide for Cloud

OL-25276-01



Chapter 3      Understanding the Automation Pack Content
  Cloud Common TAP Content
Cloud Common TAP Content
The Cloud Common automation pack ships with the content that is shared across all the Cloud 
automation packs.

Cloud Common Processes
The following table contains the processes that are imported by the Cloud Common automation pack.

The Cloud Common automation pack also contains atomic processes (activities) that can be used in 
processes. See Chapter 6, “Using the Cloud Activities.”

Process Name Description

Cloud Governor Report This process generates a report that displays information 
about the objects and resources being governed in the 
cloud, such as organziations, IP addresses, TEO targets 
and more.  The report is useful for managing these objects 
and for creating new objects.

If the process is started by a user, a Review Request will 
be generated to indicate that the report is ready to be 
viewed.

Cloud Process Execution Error This process handles all alerts generated by the cloud 
content and determines whether incidents should be 
created.

Get Organization Resources This process retrieves a list of resources assigned to an 
organization from the cloud governor (for example, 
network, data store, time zone, and host server).

IP Address Pool – Allocate Management This process is used to allocate a management address pool 
for the specified organization.

IP Address Pool – Allocate Public This process is used to allocate a public address pool for 
the specified organization.

IP Address Pool – Deallocate 
Management

This process will deallocate a management IP address pool 
for the specified organization.

IP Address Pool – Deallocate Public This process will deallocate a public IP address pool for 
the specified organization.

Obtain Template Name This process determines the VMware template to use for 
creating a new virtual server based on OS and service 
level.

Organization – Offboard This process allows you to remove an organization from 
the Cloud Governor.

Organization – Onboard This process allows you to add or update an organization 
in the Cloud Governor.

Physical Server – Add This process adds a physical server to the Cloud Governor.  
If the physical server already exists, the process will fail.

Physical Server – Delete This process deletes a physical server based on a server 
number. The server number can be found on the Cloud 
Governor Report.
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For additional information on processes, see Chapter 5, “Managing the Cloud Processes.”

Cloud Common Task Rules
The following task rule is imported by the Cloud Common automation pack.

For information on configuring Task Rules, see Using Task Rules for Assignments and Notifications, 
page 4-26.

Release IP Address This process releases an IP address that was previously 
reserved.

Release Service Target This process releases all resource allocated for a service 
target and deletes the service target.

Reserve IP Address This process retrieves the network settings (such as DNS 
and subnet) and reserves an IP address from a pool of IP 
addresses. 

TSP Template – Add This process adds a TSP template to the Cloud Governor to 
be used by TSP for bare metal provisioning of virtual and 
physical servers.

TSP Template – Delete This process deletes a TSP template for a specific 
operating system.

VM Template – Add This process is used to add a VM template to the Cloud 
Governor.

VM Template – Delete This process is used to remove a VM template from the 
Cloud Governor.

Process Name Description

Task Rule Name Description

Cloud Default Incident Assignee Contains the designated user or group who will be 
assigned incidents created by the Cloud processes.
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Cloud Common Extended Target Properties
The following table contains the extended target properties that are imported by the Cloud Common 
automation pack.

Extended Target Property Description

Cloud.Configuration.CloudGovernor Reference to a TEO SQL Server Target configured for the 
Cloud Governor.

Cloud.Configuration.newScale. 
WebService

Reference to a TEO Web Target configured for the 
newScale web service. Cloud content uses this target to 
call back into newScale to update service requests.

Cloud.Configuration.TSP.Server Reference to a TSP Server target. Cloud content uses this 
target to bare-metal provision virtual machines.

Cloud.Service.General.Owner.TEO The TEO web target that manages the service.

Cloud.Service.General.Owner. 
UCSManager

The UCS manager that manages the service.

Cloud.Service.General.Owner.VCenter The vCenter target that manages the service.

Cloud.Service.General.TargetName The display name of the TEO service target representing 
the service.

Cloud.Service.General.Type The type of service being managed. Current values used by 
Cisco Cloud target groups include:

 • Cisco Cloud Physical Server

 • Cisco Cloud Virtual Server

Cloud.Service.Organization.ID The ID of the organization that requested the service.

Cloud.Service.Organization.Name The name of the organization that requested the service.

Cloud.Service.Server.General.Domain The domain or workgroup to which the server belongs.

Cloud.Service.Server.General.Name The DNS name of the server.

Cloud.Service.Server.General.OSType The type of operating system deployed on the managed 
server (such as Windows or Linux).

Cloud.Service.Server.General. 
OSVersion

The version of the OS running on the server.

Cloud.Service.Server.General.Password.
JoinDomain

The password used to join the server to the domain.

Cloud.Service.Server.General.Password.
LocalAdministrator

The password to assign the local administrator account.

Cloud.Service.Server.General.Timezone The time zone of the server.

Cloud.Service.Server.General.User. 
JoinDomain

The user account to join the server to the domain.

Cloud.Service.Server.Network. 
Management.DNS

The management network DNS setting for the server.

Cloud.Service.Server.Network. 
Management.Gateway

The management network gateway for the server.

Cloud.Service.Server.Network. 
Management.IPAddress

The management IP address assigned to a virtual or 
physical server.
3-9
Cisco TEO—Process Automation Guide for Cloud

OL-25276-01



Chapter 3      Understanding the Automation Pack Content
  Cloud Common TAP Content
Cloud.Service.Server.Network. 
Management.Path

The name of the management network for the server.

Cloud.Service.Server.Network. 
Management.SubnetMask

The management network subnet mask for the server.

Cloud.Service.Server.Network.Public. 
DNS

The public network DNS setting for the server.

Cloud.Service.Server.Network.Public. 
Gateway

The public network gateway for the server.

Cloud.Service.Server.Network. 
Public.IPAddress

The public IP address assigned to a virtual or physical 
server.

Cloud.Service.Server.Network. 
Public.Path

The public network path for the server.

Cloud.Service.Server.Network. 
Public.SubnetMask

The network subnet mask for the server.

Cloud.Service.Server.Network.TSP.Path The network used by Tidal Server Provisioner (TSP) for 
bare metal provisioning.

Cloud.Service.Server.Physical. 
UCS.Blade

The blade number in UCS Manager.

Cloud.Service.Server.Physical. 
UCS.Chassis

The chassis number in UCS Manager.

Cloud.Service.Server.Physical. 
UCS.Organization

The Org in UCS Manager.

Cloud.Service.Server.Physical. 
UCS.ServiceProfile

The service profile in UCS Manager.

Cloud.Service.Server.Physical. 
UCS.Template

The template in UCS Manager.

Cloud.Service.Server.Virtual.CPUCount The number of CPUs allocated to the VM.

Cloud.Service.Server.Virtual.CPUCount.
Pending

The number of CPUs that are pending to be configured to 
the VM. Once the configuration is changed, the 
Cloud.Service.Server.Virtual.CPUCount extended target 
property is updated.

Cloud.Service.Server.Virtual.DataStore The VMware data store where the VM storage is located.

Cloud.Service.Server.Virtual.DiskSize The amount of storage allocated for the VM.

Cloud.Service.Server.Virtual.ESXHost The VMware ESX host that is hosting the VM.

Cloud.Service.Server.Virtual. 
InventoryPath

The path in VMware vCenter where the virtual machine is 
located.

Cloud.Service.Server.Virtual. 
MemorySize

The amount of memory allocated for the VM.

Cloud.Service.Server.Virtual. 
MemorySize.Pending

The amount of memory pending to be allocated to the VM. 
Once the configuration is changed, the 
Cloud.Service.Server.Virtual.MemorySize extended 
target property is updated.

Extended Target Property Description
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Note All extended target properties that are prefixed with “Cloud.Service” should not be configured by users. 
These properties are configured by the processes.

For information on configuring extended target properties, see Managing Extended Target Properties, 
page 4-21.

Cloud Common Target Groups
The following target groups are improted by the Cloud Common automation pack. For additional 
information on using target groups, see the Tidal Enterprise Orchestrator Reference Guide.

Cloud.Service.Server.Virtual.Provision
Method

The method used to provision the server (for example, 
Clone or TSP).

Cloud.Service.Server.Virtual. 
ResourcePool

The VMware resource pool for the VM.

Cloud.Service.Server.Virtual.Snapshot The location of the last snapshot of the virtual server.

Cloud.Service.Server.Virtual. 
SnapshotDate

The date of the last snapshot of the virtual server.

Cloud.Service.Server.Virtual. 
TemplateFolder

The folder containing the VM template to use for cloning.

Cloud.Service.Server.Virtual. 
TemplateName

The name of the template used to close the VM.

Cloud.Service.Server.Virtual. 
VMFullName

The full name of the virtual machine (VM path and VM 
name).

Extended Target Property Description

Target Group Name Description

Cloud All Configured Targets Contains all the cloud target groups. This target group is 
used for resolving affected targets in the cloud alert handler 
process.

Cloud All Services Contains all service targets configured in TEO (includes 
service targets that are managed and not managed by Cisco 
cloud content).

Cloud Managed Physical Servers Contains the physical servers provisioned and managed by 
Cisco cloud content.

Cloud Managed Services Contains all services managed by Cisco cloud content.

Cloud Managed Virtual Servers Contains virtual servers provisioned and managed by Cisco 
cloud content.

Cloud newScale Web Targets Contains all configured newScale web targets.

Cloud SQL Server Targets Contains all configured Microsoft SQL Server targets.

Cloud TEO Web Targets Contains all configured TEO web targets.
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Cloud Common Categories
The following categories are imported by the Cloud Common automation pack. For information on using 
categories, see the Tidal Enterprise Orchestrator Reference Guide.

Cloud Common Global Variables
The following global variables are imported by the Cloud Common automation pack.

Cloud TSP Server Targets Contains all configured Tidal Server Provisioner targets.  
Cloud content uses extended target properties to find the 
TSP server for provisioning.

Cloud UCS Manager Targets Contains all configured Cisco UCS Manager targets.  
Cloud content uses extended target properties to find the 
UCS Manager for provisioning.

Cloud VCenter Targets Contains all configured vCenter targets. Cloud content 
uses extended target properties to find the appropriate 
vCenter server hosting a VM.

Cloud Web Targets Contains all configured web service targets. Cloud content 
uses extended target properties to find the newScale and 
TEO web service targets.

Cloud Windows Targets Contains all configured Windows targets. Cloud content 
uses extended target properties to find the TEO Windows.

Target Group Name Description

Category Name Description

Cloud All processes and objects related to Cisco cloud 
automation.

Cloud Common Objects shared across all Cisco cloud content.

Cloud Governor A group of processes to manage and monitor the Cloud 
Governor database.

Cloud Governor Operations Processes used to manage the Cloud Governor 
database, such as onboarding a new customer or 
allocating an IP address pool.

Global Variable Name Description

Cloud Default Virtual Server Clone Timeout The default period of time, specified in minutes, for a 
VMware clone operation to timeout.

Cloud Domain Account A domain account with permission to join a new server 
to the domain.

Cloud Domain Account Password The password for the domain account used to join new 
servers to the domain.

Cloud Duplicate Alert Suppression Time 
Period

The amount of time, in hours, to suppress duplicate 
alerts related to cloud automation.
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Cloud newScale Service Catalog TAP Content
The Cloud newScale Service Catalog automation pack contains the content that is required to integrate 
newScale Service Catalog with the Cisco cloud solution.

Cloud newScale Service Catalog Processes
The following table contains the processes that are imported by the Cloud newScale Service Catalog 
automation pack.

For additional information on processes, see Chapter 5, “Managing the Cloud Processes.”

Cloud IP Address Pool Error Threshold The threshold to generate an error alert when the 
percentage of IP addresses used exceed this value.

Cloud IP Address Pool Warning Threshold The threshold to generate a warning alert when the 
percentage of IP addresses used exceed this value.

Cloud New Server Password The password that will be assigned to the local 
Administrator account for new Windows servers and 
the root password for Linux servers.

UCS Boot Policy – Local Disk The the name of a Boot Policy, defined in UCS 
Manager, that sets the boot order to boot from Local 
Disk first.

Global Variable Name Description

Process Name Description

newScale Complete Service Request This process is triggered by a change request being 
completed. It marks the associated newScale service 
request as completed.

newScale Failed Service Request This process is triggered by a change request failing. It 
marks the associated newScale service request as 
completed.

newScale Service Request Handler This process is called directly by newScale service catalog, 
using the TEO web service, to process a new service 
request. The process will create or locate the appropriate 
TEO service target and trigger a fulfillment process to 
handle the request.

newScale Service Request Manager This process obtains the request from newScale and routes 
it to the appropriate TEO owner for processing.

newScale Update Service Request 
History

This process will add a note to the history of a newScale 
service request. It is triggered by a note being added to a 
TEO change request.
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Cloud newScale Service Catalog Categories
The following category is imported by the Cloud newScale Service Catalog automation pack. For 
information on using categories, see the Tidal Enterprise Orchestrator Reference Guide.

Cloud Physical Server Automation TAP Content
The Cloud Physical Server Automation automation pack contains the infrastructure related processes for 
creating and managing physical machines.

Cloud Physical Server Processes
The following table contains the processes that is imported by the Cloud Physical Server automation 
pack.

For additional information on processes, see Chapter 5, “Managing the Cloud Processes.”

Cloud Physical Server Categories
The following category is imported by the Cloud Physical Server automation pack. For information on 
using categories, see the Tidal Enterprise Orchestrator Reference Guide.

Category Name Description

Cloud newScale Service Catalog Processes and other object required for integration with 
newScale service catalog.

Process Name Description

Delete Physical Server This process removes a physical server from service.

Install OS on Physical Server This process installs the OS on a physical server using 
TSP.

Category Name Description

Cloud Physical Server Automation Processes and other objects required to automate the 
creation and management of physical servers.
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Cloud Virtual Server Automation TAP Content
The Cloud Virtual Server Automation automation pack contains the infrastructure related processes for 
creating and managing virtual servers.

Cloud Virtual Server Processes
The following table contains the processes that is imported by the Cloud Virtual Server automation pack.

For additional information on processes, see Chapter 5, “Managing the Cloud Processes.”

Cloud Virtual Server Categories
The following category is imported by the Cloud Virtual Server automation pack. For information on 
using categories, see the Tidal Enterprise Orchestrator Reference Guide.

Process Name Description

Allocate and Reserve Virtual Resources This process reserves the resources and creates a new 
virtual server, either by cloning from a template or bare 
metal provisioning.

Create Virtual Server From Bare Metal This process creates a new virtual server and installs an OS 
on it using TSP.

Create Virtual Server From Template This process creates a new virtual server by cloning an 
existing VM template.

Customize Virtual Server This process configures the VM memory, CPUs, networks, 
storage, and OS.

Delete Virtual Server This process takes a virtual machine out of service and 
decommission the server.

Modify Virtual Server Configuration This process modifies the CPU and memory settings on a 
virtual machine.

Category Name Description

Cloud Virtual Server Automation Processes and other objects required to automate the 
creation and management of virtual servers.
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Cloud Service Orchestration TAP Content
The Cloud Service Orchestration automation pack contains the processes for orchestrating fulfillment of 
cloud service requests.

Cloud Service Orchestration Processes
The following table contains the processes that is imported by the Cloud Service Orchestration 
automation pack.

Process Name Description

Commission Physical Server This process orchestrates the entire process of 
deploying a physical Linux server on a UCS blade.  
This includes reserving the required resources, 
installing the Linux operating system, and updating 
external systems.

Commission Virtual Linux Server This process orchestrates the entire process of 
deploying a virtual Linux server on a VMware ESX 
server.  This includes reserving the required resources, 
creating the VM, installing the Linux operating system, 
updating external systems and notifying the user when 
the service is available for use.

Commission Virtual Server from Template This process orchestrates the entire process of cloning 
a virtual server on a VMware ESX server. This includes 
reserving the required resources, modifying the guest 
OS, updating external systems and notifying the user 
when the service is available for use.

Decommission Physical Server This process orchestrates the entire process of 
decommissioning a physical server. This includes 
powering off the UCS blade, freeing up resources, and 
notifying the user when the server is no longer 
available.

Decommission Virtual Server This process orchestrates the entire process of 
decommissioning a virtual server on a VMware ESX 
server. This includes powering off the VM, freeing up 
resources, marking the VM for deletion, updating 
external systems and notifying the user when the 
service is no longer available.

Modify Virtual Server This process orchestrates the entire process of 
modifying the settings of a virtual server on a VMware 
ESX server. This includes the number of CPUs, 
memory, storage, updating external systems and 
notifying the user when the service has been modified.

Power Off Virtual Server This process orchestrates the entire process of 
powering off a virtual server on a VMware ESX server.

Reset Virtual Server This process orchestrates the entire process of resetting 
a virtual server on a VMware ESX server.
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For additional information on processes, see Chapter 5, “Managing the Cloud Processes.”

Cloud Service Orchestration Categories
The following category is imported by the Cloud Service Orchestration automation pack. For 
information on using categories, see the Tidal Enterprise Orchestrator Reference Guide.

Revert Snapshot Virtual Server This process orchestrates the entire process of reverting 
a snapshot of a virtual server. This includes prompting 
the user for the snapshot to revert, reverting the 
snapshot and notifying the user when the process is 
complete.

Snapshot Virtual Server This process orchestrates the entire process of making 
a snapshot of a virtual server on a VMware ESX server.

Process Name Description

Category Name Description

Cloud Service Orchestration Processes and other objects required to orchestrate the 
creation and management of cloud services.
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C H A P T E R 4

Getting Started Using the Automation Pack

Before you begin using the content that ships with the automation pack, you must create the objects in 
TEO that are referenced in the processes. These objects include targets, runtime users, task rules for 
assignments and notifications, and extended target properties.

This chapter provides basic information on defining the objects. It includes the following sections:

 • Creating Runtime User Accounts, page 4-2

 • Creating Targets, page 4-4

 • Managing Extended Target Properties, page 4-21

 • Managing Global Variables, page 4-24

 • Using Task Rules for Assignments and Notifications, page 4-26

For additional information about the objects discussed in this chapter, refer to the following 
documentation:

Document Description

Tidal Enterprise Orchestrator Reference Guide General information about Core product features.

Cisco TEO Adapter Guide for Tidal Server 
Provisioner

General information about the objects provided by 
the Tidal Server Provisioner adapter.

Cisco TEO Adapter Guide for VMware General information about the objects provided by 
the VMware adapter.

Cisco TEO Software Adapter Guide for Cisco 
UCS

General information about the objects provided by 
the Cisco UCS Software adapter.

Cisco TEO Adapter Guide for Web Services General information about the objects provided by 
the Web Services adapter.
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Creating Runtime User Accounts
The Runtime User is the account that holds the credentials for connecting to the targets. The Cloud 
environment requires targets that use the Runtime User type and the Tidal Server Provisioner User type 
accounts.

Creating a Runtime User
The Runtime User is the type of runtime user account that is used to connect to the following types of 
targets:

 • newScale Server Web Target

 • VMware Virtual Center Server Targets

 • Cisco UCS Manager Targets

 • Cloud Governor Database Target (Runtime User or Windows User)

 • Tidal Server Provisioner Target (Tidal Server Provisioner User)

Note For additional information on creating and managing runtime users, see the Tidal Enterprise 
Orchestrator Reference Guide.

Step 1 Open the New Runtime User dialog box using one of the following methods:

 • In the Definitions workspace, right-click Runtime Users in the navigation pane and choose New > 
Runtime User.

 • On the New Target Properties dialog box, click New > Runtime User in the Default runtime user 
field.

Step 2 On the General tab, specify the following information:

Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value.

Field Description

Display name Enter a name for the user account.

User name Enter the user name assigned to the user account that 
connects to the target.

Password Check the check box and enter the password assigned 
to the user account.

Note No password verification is done for the simple 
(generic) runtime user.

Description A description of the user account.
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Step 3 Click OK to close the dialog box.

Creating Tidal Server Provisioner User
The Tidal Server Provisioner user is the account used to connect to the Tidal Server Provisioner Server 
target.

Step 1 On the Definitions workspace, right-click Runtime User and choose New > Tidal Server Provisioner 
User to display the New Tidal Server Provisioner User Properties dialog box.

Figure 4-1 New Tidal Server Provisioner User Properties—General Tab

Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value.

Step 2 Specify the information in the following text fields:

Field Description

Display name Enter the name to be assigned to the user account. This is 
the name that will display in the Runtime Users view.

Type Display only. Type of object.

Owner Name of the user who owns the object. Click the Browse 
 tool to change the owner.

User name Enter the user name for the account that connects to the 
Tidal Server Provisioner server.
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Step 3 Click OK to close the dialog box.

Creating Targets
Before you can create or run processes, you must create the targets on which the processes will run. This 
section guides you through creating the following target types that are used in the Cloud processes.

Password Enter the password that is assigned to the Tidal Server 
Provisioner user account.

Authorization APID Enter the authorization APID assigned to the user account.

Note For information on obtaining an authorization 
APID, see the Cisco TEO Adapter Guide for Tidal 
Server Provisioner.

Description Optional. Enter a description of the runtime user account.

Field Description

Target/Type Where Used

TEO Servers/Web Target The web target for the local TEO server is created when 
the Cloud Common automation pack is imported (Tidal 
Enterprise Orchestrator Web Service). However, if this 
TEO server will serve as a request manager you will 
also need to configure a web target for each TEO server 
that will process service requests.

It is recommended that you use a naming convention for 
secondary TEO web targets that easily identifies the 
type of requests that are routed to the server (for 
example, TEO Accounting, TEO Product 
Development, etc.).

newScale Server/Web Target The web target that TEO uses to communicate notes 
and status of service catalog requests to newScale.

VMware Virtual Center Server Targets A VMware Virtual Center Server target needs to be 
configured for each vCenter that will manage virtual 
machines in the cloud.

It is recommended that you use a naming convention for 
vCenter targets that easily identifies the virtual 
machines the target manages (for example, VMware 
vCenter Accounting, VMware vCenter Product 
Development, etc.).
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Cisco UCS Manager Targets A Cisco UCS Manager target needs to be configured for 
each Cisco UCS Manager that will manage physical 
machines in the cloud.

It is recommended that you use a naming convention for 
Cisco UCS Manager targets that easily identifies the 
Cisco UCS Manager instances the target manages (for 
example, UCS Accounting, UCS Product Development, 
etc.).

Tidal Server Provisioner Target A Tidal Server Provision target needs to be configured 
for bare metal provisioning.

Cloud Governer Database Target A SQL Server Database target needs to be configured 
for the Cloud Governor Database.

The Cloud Governor Database target needs to have full 
rights to the database and the runtime user needs full 
permissions to the database.

Note The Cloud Governor Database is created when 
the Cloud Common automation pack is 
imported. See Creating Cloud Governor 
Database, page 2-2.

Target/Type Where Used
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Creating Web Targets for newScale and TEO Servers
You use the Web target type to create a target for the newScale server and secondary TEO servers. Use 
the New Web Target Properties dialog box to create the Web target.

Step 1 On the Definitions workspace, right-click Targets and choose New > Web Target to open the New Web 
Target Properties dialog box.

Figure 4-2 New Web Target Properties—General Tab

Step 2 On the General tab, enter the information in the following text fields:

Step 3 Click the Connection tab.

Field Description

Display name Name for the target. This is the name that will display 
in the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically 
the person who created the target.

Status Display only. Status of the target.

Status information Display only. Detailed information regarding the target 
status.

Organization Name of the company that supports the target.

Description Optional field to enter a description for the target.
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Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value.

Figure 4-3 New Web Target Properties—Connection Tab

Step 4 On the Connection tab, specify the following connection information for the target:

Field Description

Base Url Enter the appropriate target URL to use as a base for the 
execution.

For example:
http://doc-dev.domain.com:61527/WS

Runtime User Click one of the following radio buttons to indicate which 
runtime user account to use to connect to the target:

 • No runtime user—Select this radio button to indicate 
that no runtime user is required to execute a process or 
activity against the target.

 • Default runtime user—Select this radio button and 
then choose the default runtime user account that 
contains the credentials to connect to the target.

Note To view the properties for the selected runtime 
user, click the Properties  tool. 
 
To create a new runtime user account, click New 
and then choose Runtime User or Windows User. 
 
See Creating a Runtime User, page 4-2.
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Step 5 Click OK to close the dialog box and complete the procedure.

The Web target displays in the Targets pane.

Creating VMware Virtual Center Server Targets
A VMware Virtual Center Server target needs to be configured for each vCenter that will manage virtual 
machines in the cloud.

It is recommended that you use a naming convention for vCenter targets that easily identifies the virtual 
machines the target will manage (for example, TEO Accounting, TEO Product Development, etc.).

Use the New VMware Virtual Center Server Properties dialog box to create the target.

Step 1 On the Definitions workspace, right-click Targets and choose New > VMware Virtual Center Server 
to open the New VMware Virtual Center Server Properties dialog box.

Figure 4-4 New VMware Virtual Center Server Properties—General Tab

Ignore certificate errors Check or uncheck the check box to indicate whether the 
target should ignore any certificate errors on the specified 
web site. If the check box is checked, all errors will be 
ignored.

Field Description
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Step 2 On the General tab, enter the information in the following text fields:

Step 3 Click the Connection tab.

Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value.

Figure 4-5 New VMware Virtual Center Server Properties—Connection Tab

Field Description

Display name Name for the target. This is the name that will display in 
the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically the 
person who created the target.

Status Display only. Status of the target.

Status information Display only. Detailed information regarding the target 
status.

Organization Name of the company that supports the target.

Description Optional field to enter a description for the target.
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Step 4 On the Connection tab, specify the following connection information for the target:

Step 5 Click OK to close the dialog box and complete the procedure.

The VMware Virtual Center Server target displays in the Targets pane.

Field Description

Virtual Center server name Enter the fully-qualified domain name (FQDN) or IP 
address of the virtual center.

Virtual Center service port Port number used to access the virtual center (default 
port is 443).

Use the credentials of the following runtime 
user

Choose the default runtime user account to connect to 
the target from the drop-down list.

Note To view the properties for the selected runtime 
user, click the Properties  tool. 
 
To create a new runtime user account, click 
New and then choose Runtime User. 
 
See Creating a Runtime User, page 4-2.

HTTPS Check or uncheck the check box to indicate whether 
HTTPS will be set if the Virtual Center web service has 
been configured to use HTTPS protocol.

If HTTPS protocol is not used on the Virtual Center, 
uncheck the check box.
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Creating Cisco UCS Manager Targets
A Cisco UCS Manager target needs to be configured for each Cisco UCS Manager that will manage 
physical machines in the cloud.

It is recommended that you use a naming convention for the Cisco UCS Manager targets that easily 
identifies the Cisco UCS Manager instances the target will manage (for example, TEO Accounting, TEO 
Product Development, etc.).

Use the New Cisco UCS Manager Properties dialog to create Cisco UCS Manager targets.

Step 1 In the Definitions view, right-click Targets and choose New > Cisco UCS Manager from the submenus.

The New Cisco UCS Manager Properties dialog box displays.

Figure 4-6 New Cisco UCS Manager Properties—General Tab

Step 2 On the General tab, enter the following general information about the target:

Field Description

Display name Name of the target that displays in the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically the 
person who created the target.

Click the Browse  tool to change the owner.

Status Display only. Indicates the status of the target. The status 
determines whether the target is available or unavailable 
for process or activity execution.

Status Information Display only. Detailed information regarding the target 
status and the reasons for the target being unreachable.
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Step 3 Click the Connection tab to specify the connection information for the Cisco UCS Manager target.

Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value.

Figure 4-7 New Cisco UCS Manager Properties—Connection Tab

Step 4 On the Connection tab, specify the following information:

Organization Name of the company that supports the target.

Description Text description of the target.

Enabled Check or uncheck the check box to enable or disable the 
target. The check box is checked by default which makes it 
available immediately upon creation.

If you uncheck the check box, the target is disabled and 
will be unavailable for execution.

Field Description

Field Description

UCS Manager host name Enter the IP address or name of the server that hosts the 
UCS Manager.

UCS Manager port number Port number for connecting to the Cisco UCS Manager 
target. By default, port 443 is used for SSL protocol and 
port 80 is used for http connection.

Access UCS Manager via Secure Socket 
Layer (SSL)

This check box is checked by default to indicate that 
SSL protocol is used to connect to the host server. 
Uncheck the check box if SSL protocol is not used.
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Step 5 Click the Options tab.

Figure 4-8 New Cisco UCS Manager Properties—Options Tab

Ignore Secure Socket Layer (SSL) certificate 
error

This check box is checked by default to indicate that 
certificate error messages should be ignored.

Default runtime user Runtime user account to be used to connect to the 
target. Select the default runtime user from the 
drop-down list.

Note To view the properties for the runtime user, 
click the Properties  tool. 
 
To create a new runtime user, click New and 
then choose Runtime User. 
 
See Creating a Runtime User, page 4-2.

UCS Manager time zone Choose the time zone that is used on the UCS Manager 
server.

UCS Manager version Firmware version installed on the UCS Manager. This 
field is blank until the target is created. The version 
displays on the target properties.

Field Description
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Step 6 Specify the following polling information for the UCS Manager target:

Step 7 Click OK to complete the procedure and close the dialog box.

The Cisco UCS Manager target displays in the Targets pane.

Field Description

Timeout for UCS Manager activity Enter the number of seconds to wait for a UCS actvity 
fails because it timed out. The default timeout value is 
120 seconds.

UCS faults polling interval Enter the number of seconds to represent how often the 
UCS Manager target should be polled for faults. The 
default value is 60 seconds.

Archive all UCS audit logs as Reporting 
Database events

Check this checkbox if you want all UCS audit logs to 
be archived as events in the Reporting Database. 
Uncheck the checkbox if you do not want to archive the 
UCS audit logs.

UCS audit logs polling interval If the Archive all UCS audit logs as Reporting Database 
events check box is checked, enter the number of 
seconds to represent how often the UCS audit logs 
should be polled. The default value is 600 seconds.
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Creating Tidal Server Provisioner Target
A Tidal Server Provision target needs to be configured for the Tidal Server Provisioner server, which is 
used for bare metal provisioning.

Use the Connection tab on the New Tidal Server Provisioner Properties dialog box to create the Tidal 
Server Provisioner target.

Step 1 In the Definitions view, right-click Targets and choose New > Tidal Server Provisioner from the 
submenus to open the New Tidal Server Provisioner Properties dialog box.

Figure 4-9 New Tidal Server Provisioner Properties—General Tab

Step 2 On the General tab, enter the following general information about the target:

Field Description

Display name Name of the target that displays in the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically the 
person who created the target.

Click the Browse  tool to change the owner.

Status Display only. Indicates the status of the target. The status 
determines whether the target is available or unavailable 
for process or activity execution.

Status Information Display only. Detailed information regarding the target 
status and the reasons for the target being unreachable.

Organization Name of the company that supports the target.
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Step 3 Click the Connection tab to specify the connection information for the Tidal Server Provisioner target.

Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value.

Figure 4-10 New Tidal Server Provisioner Properties—Connection Tab

Step 4 On the Connection tab, specify the following information:

Description Text description of the target.

Enabled Check or uncheck the check box to enable or disable the 
target. The check box is checked by default which makes 
it available immediately upon creation.

If you uncheck the check box, the target is disabled and 
will be unavailable for execution.

Field Description

Field Description

Host name or IP address Enter the IP address or name of the server that hosts 
Tidal Server Provisioner.

Port Port number for connecting to the Tidal Server 
Provisioner target. By default, port 80 is used for http 
connection.
4-16
Cisco TEO—Process Automation Guide for Cloud

OL-25276-01



 

Chapter 4      Getting Started Using the Automation Pack
  Creating Targets
Step 5 Click OK to complete the procedure and close the dialog box.

The Tidal Server Provisioner target displays in the Targets pane.

Creating SQL Server Database Targets
The SQL Server Database target type is used for the Cloud Governor Database target and the newScale 
RequestCenter Database target.

Use the New SQL Server Database Properties dialog to create the targets.

Creating Cloud Governor Database Target

Step 1 In the Definitions view, right-click Targets and choose New > SQL Server Database from the 
submenus to open the New SQL Server Database Properties dialog box.

Default runtime user Choose the runtime user account to be used to connect 
to the target from the drop-down list.

Note To view the properties for the runtime user, 
click the Properties  tool.  
 
To create a new runtime user, click New and 
then choose Tidal Server Provisioner User. 
 
See Creating Tidal Server Provisioner User, 
page 4-3.

Field Description
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Figure 4-11 New SQL Server Database Properties—General Tab

Step 2 On the General tab, enter the following general information about the target:

Step 3 Click the Connection tab to specify the connection information for the SQL Server Database target.

Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value.

Field Description

Display name Name of the target that displays in the Targets pane.

Type Display only. Type of target.

Owner User name of the owner of the target. This is typically 
the person who created the target.

Click the Browse  tool to change the owner.

Status Display only. Indicates the status of the target. The 
status determines whether the target is available or 
unavailable for process or activity execution.

Status Information Display only. Detailed information regarding the target 
status and the reasons for the target being unreachable.

Organization Name of the company that supports the target.

Description Text description of the target.

Enabled Check or uncheck the check box to enable or disable the 
target. The check box is checked by default which 
makes it available immediately upon creation.

If you uncheck the check box, the target is disabled and 
will be unavailable for execution.
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Figure 4-12 New SQL Server Database Properties—Connection Tab

Step 4 On the Connection tab, specify the following information:

Step 5 Click the Permissions tab.

Field Description

Server Enter the IP address or name of the server.

Database name Enter the name of the database.

Database owner Enter the name of the database owner.

Default timeout for activities (seconds) Indicates the length of time to wait before a command is 
complete.

Default runtime user Choose the runtime user account to be used to connect to 
the target from the drop-down list.

Note To view the properties for the runtime user, click 
the Properties  tool.  
 
To create a new runtime user, click New and then 
choose Runtime User or Windows User. 
 
See Creating a Runtime User, page 4-2.
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Figure 4-13 New SQL Server Database Properties—Permission Tab

Step 6 Click the Execute SQL command radio button.

Step 7 Click OK to complete the procedure and close the dialog box.

The Cloud Governor Database target displays in the Targets pane.
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Managing Extended Target Properties
Once the Cloud targets are created, you must configure certain Extended Target Properties to reference 
these targets so cloud processes are aware of them. Other extended target properties are configure 
dynamically by the cloud processes.

This section provides information on viewing or modifying the extended target properties (target 
references) that ship with the Cloud Common automation pack.

Accessing Extended Target Properties
The extended target properties that ship with the Cloud automation packs can be accessed from the 
Definitions—Extended Target Properties view. 

Step 1 On the Console, select the Definitions workspace and click Extended Target Properties in the 
navigation pane. By default, all the properties display in the Extended Target Properties pane.

Figure 4-14 Definitions—Extended Target Properties View

The following information about the extended target properties displays by default:

Column Description

Display Name Name of the target property.

Description Text description of the target property.

Value Value assigned to the target property.

Data Type Type of value being used for the target property (Boolean, 
Encrypted String, Identity, Numeric, String, Table).

Automation Pack Name of the automation pack that provides the target 
property.

Customizable Indicates the customization setting for the target property 
in the automation pack.
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Step 2 Click the Filter by link and choose Automation Pack > [Automation Pack Name] to filter for only the 
extended target properties that ship with the specific automation pack.

Note The extended target properties for the Cloud processes ship in the Cloud Common automation 
pack.

Configuring References to Targets
The Cloud extended target properties include target references that must be configured to reference the 
Cloud targets. The following target references must be configured:

 • Cloud.Configuration.CloudGovernor—References the TEO SQL Server Database target that is 
configured for the CloudGovernor database.

 • Cloud.Configuration.newScale.WebService—References the TEO Web target configured for the 
newScale web service. The Cloud content uses this target to call back into newScale to update 
service requests.

 • Cloud.Configuration.TSP.Server—References the TEO TSP Server target. The Cloud content uses 
this target to bare-metal provision virtual machines.

Use the Extended Target Properties feature to reference the targets.

Step 1 On the Definitions workspace, click Extended Target Properties.

Step 2 Filter by Automation Pack and choose Cloud Common from the drop-down list.

Step 3 In the Extended Target Properties pane, right-click the extended target property (reference) and choose 
Properties.

Target Types Indicates the targets associated with the target property.

Last Modified Time Date and time the variable was last modified.

Last Modified By Name of the user who last modified the target property.

Id Unique ID of the target property.

Owner User name of the owner of the target property. This is 
typically the person who created the target property.

Created Time Date and time the target property was created.

Created By User name of the person who created the target property.

Column Description
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Figure 4-15 Extended Target Properties—General Tab

Step 4 In the Value text field, click the Browse  tool to open the Select Target dialog box.

Figure 4-16 Select Target

Step 5 On the Select Target dialog box, select the appropriate target and click OK.

Step 6 Click OK to close the Extended Target Properties dialog box. 
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Managing Global Variables
The processes use global variables for information that is used on a regular basis to avoid having to 
specify the same information in several processes or activities. The global variables that ship with the 
automation pack are configured with default values but can be modified to meet the requirements for 
your specific environment.

This section provides instructions for accessing the global variables that ship with the Cloud Common 
automation pack and modifying the default values.

Accessing Global Variables
The global variables that ship with the Core Automation for SAP automation pack can be accessed from 
the Definitions—Global Variables view. 

Step 1 On the Console, select the Definitions workspace and click Global Variables in the navigation pane. By 
default, all the variables display in the Global Variables pane.

Step 2 Click the Filter by link and choose Automation Pack > Cloud Common to filter for only the global 
variables that ship with the specific automation pack.

Figure 4-17 Global Variables View

The following information about the variables displays by default:

Column Description

Display Name Name of the global variable.

Description Brief overview of the global variable.

Value Value of the variable.

Data Type Type of value being used for the variable (Boolean, 
Encrypted String, Identity, Numeric, String, Table).

Automation Pack Name of the automation pack that provides the object.
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Modifying Global Variable Default Values
Most of the global variables that ship with the Cloud content have default values configured. However, 
you can modify these default values.

There are also a few global variables that do not ship with default values and these variables must be 
configured prior to being used in the processes. The following global variables must be configured by 
the user:

 • Cloud Domain Account

 • Cloud Domain Account Password

 • Cloud New Server Password

You use the Global Variable Properties dialog box to configure the global variables or modify the default 
values. 

Step 1 In the Definitions view, click Global Variables in the navigation pane to display the variables in the 
Global Variables pane.

Step 2 Click the Filter by link and choose Automation Pack > Cloud Common to filter for only the global 
variables that ship with the Cloud Common automation pack.

Step 3 In the Global Variables pane, right-click the global variable and choose Properties.

Figure 4-18 Global Variable Properties—General Tab

Last Modified Time Time the global variable was last modified.

Last Modified By Name of the user who last modified the global variable.

Column Description
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Step 4 In the Value text field, enter the new value and click OK.

Using Task Rules for Assignments and Notifications
Task rules are used to manage task assignments and notifications for tasks, such as incidents and alerts, 
that are generated from processes. When you import the Cloud Common automation pack, you are 
prompted to specify the default user or group who should be assigned Cloud related incidents. By 
default, this person will receive all assignments unless task rules are created to specify alternate users or 
groups for specific tasks. In addition, email notifications will not be sent unless you create a task rule to 
send a notification.

This section guides your through configuring the task rules and provides instructions for creating and 
managing task rules.

Note If you do not want to create task rules for email notifications, you can use the default notification based 
on assignment processes that ship with the Core automation pack. These processes are disabled by 
default and must be enabled if you want notifications to be sent (see Enabling Notification Based on 
Assignment Processes, page 4-39).

Accessing Task Rules View
The task rules that ship with the Cloud automation packs can be accessed from the Definitions—Task 
Rules view. 

Step 1 On the Console, select the Definitions workspace and click Task Rules in the navigation pane. By 
default, all the rules display in the Task Rules pane.

Step 2 Click the Filter by link and choose Automation Pack > [Automation Pack Name] to filter for only the 
task rules that ship with the specific automation pack.
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Figure 4-19 Definitions—Task Rules View

The following information about the task rules displays by default: 

Column Description

Display Name The name assigned to the task rule. 

Enabled Indicates whether the task rule is enabled (True) or 
disabled (False). A disabled task rule is unavailable for 
execution.

Type Type of task.

Owner User name of the person or group who assigned the task 
rule.

Last Modified Time The date and time the task rule was last modified.

Last Modified By The object or user name that last modified the task rule.

Id Unique ID of the task rule. 

Description Brief description of the task rule.

Type Description Brief overview of the task rule type.

Created Time Time at which the task rule was created.

Created Date Date the task rule was created.

Automation Pack Name of the automation pack associated with the task rule.
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Configuring Task Rules
Use the Task Rules view to configure the task rule that ships with the Cloud Common automation pack.

Cloud Default Incident Assignment

The Cloud Default Incident Assignment task rule is used to assign incidents that are created by the Cloud 
automation packs to a default user or group. During the automation pack import process you are 
prompted for the default assignee. If you did not configure the assignee during the import process or if 
you want to modify the assignee, use the following procedure to specify the assignment information.

Step 1 In the Definitions workspace, click Task Rules in the navigation pane to display the task rules in the 
results pane.

Step 2 Click the Filter by link and choose Automation Pack, and then choose Cloud Common from the 
drop-down list.

Step 3 Right-click Cloud Default Incident Assignment and choose Properties to open the Cloud Default 
Incident Assignment Properties dialog box.

Step 4 Click the Assign tab to specify the user or group that should receive notifications for incidents and alerts 
generated by the processes.

Step 5 On the Assign tab, click Add to open the Select Assignee to Add dialog box.

Figure 4-20 Adding Assignees to Task Rule 

Step 6 On the Select Assigneed to Add dialog box, specify the assignees using one of the following methods:

 • Click the Reference  tool to select the appropriate variable reference containing the assignee or 
list of assignees from the Insert Variable Reference dialog box.

 • Click the Browse  tool to launch the Select User or Group dialog box to add user to the list of 
assignees.

Step 7 Click OK to add the assignee to the task rule.
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Figure 4-21 Task Rule Properties—Assign Tab with Assignee

Step 8 When you have completed adding assignees to the task rule, click OK to close the dialog box.

Creating a New Task Rule
Use the Task Rules view to create a new task rule. The procedure is the same for all types of task rules 
with the exception of the task-specific tab (Assign, Notify, Update) for the type of task rule you are 
creating.

Note Only users with administrative rights can create task rules in TEO. 

You can create the following types of task rules:

Step 1 In the Definitions workspace, right-click Task Rules and choose New > [Task Rule Type] to open the 
New Rule Properties dialog box. 

Task Rules Description

Assign Task Rule Assigns users to a task. 

Notify Task Rule Notifies users that a task has been created.

Update Task Rule Specifies the properties to be updated in a task..
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Figure 4-22 New Rule Properties Dialog Box—General Tab

Step 2 On the General tab, enter the following information:

Step 3 Click the Task Types tab to specify the types of tasks to be executed by the rule.

Field Description

Display Name Name of the task.

Type Display only. Shows the type of object.

Trigger Display only. Type of trigger associated with the task 
rule.

Owner User name of the owner of the task rule. This is 
typically the person who created the task rule. 

Click the Browse  tool to launch the Select User or 
Group dialog box to change the owner.

Description A brief description of the task rule.

Enabled The check box is checked by default to indicate that the 
task rule is available for execution. 

Uncheck the check box to disable the task rule.  If the 
check box is unchecked, the task rule is disabled and 
will be unavailable for execution.
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Figure 4-23 New Rule Properties Dialog Box—Task Types Tab

Step 4 Check the check box for the type of task that will execute the rule. 

Step 5 Click the Conditions tab to specify the conditions of when the task rule action is to be taken based on 
an evaluation of the defined conditions. 

Note The Required Value  icon displayed on a tab or page indicates that the field is required and 
is missing a value.

Task Type Description

Alert Alerts reflect potential problems that a user may want to 
investigate and possibly diagnose the problem.

Approval Request Specifies the message and choices for the assignee who is 
approving the task.

Guided Operation Details the steps a user takes to complete an assigned task.

Incident Task requires an operator to take action in order to resolve 
an issue.

Input Request Task requires input from an individual or group.

Review Task assigns a document for review.
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Figure 4-24 New Rule Properties Dialog Box—Conditions Tab

Step 6 On the Conditions tab, define the conditions that must be met for the rule to execute.

Defining a Basic Condition:

a. On the Basic page, click New to add a new property for the condition that must be met.

Figure 4-25 New Rule Properties Dialog Box—Basic Condition

b. In the Property text field, click the Reference  tool to choose a defined variable or reference an 
object on the Insert Variable Reference dialog box.

c. Choose the condition expression from the drop-down list.

d. Enter the condition description in the text box or click the Reference  tool to choose a defined 
variable or reference an object on the Insert Variable Reference dialog box.

e. Click New to define additional properties, if necessary.
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Defining an Advanced Condition:

a. Click the Advanced tab to define a specific type of condition (Compound, Prior Process Instance, 
Time, or Variable).

Figure 4-26 New Rule Properties Dialog Box—Advanced Condition

b. Click the link to modify the option for the condition equation. 

c. Click New and choose the type of condition from the drop-down list.

d. Specify the relevant information for the type of condition selected.

Note Click NewClick the Reference  tool to choose a defined variable or reference an object 
on the Insert Variable Reference dialog box.

e. Click New to define additional properties, if necessary.

Step 7 Click the task rule specific tab (Assign, Notify, or Update) and specify the relevant information for the 
specific type of rule.

Option Description

AND condition (all conditions must be 
met)

Click this option if an action is to be taken only when all 
conditions in the list are true.

OR condition (one condition must be 
met)

Click this option if an action is to be taken when one 
condition in the list is true.
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Assign Task Rule

If you are creating an Assign Task Rule, the Assign tab displays on the New Rule Properties dialog box.

Figure 4-27 New Rule Properties Dialog Box—Assign Tab

Step 8 On the Assign tab, specify the assignees for task rule. 

Field Description

Add Click this button to launch the Select Assignee to Add 
dialog box to specify the assignees. 

On the Select Assignee to Add dialog box, use one of 
the following methods to specify the assignee:

 • Click the Reference  tool to select the 
appropriate variable reference containing the 
assignee or list of assignees from the Insert 
Variable Reference dialog box.

 • Click the Browse  tool to launch the Select User 
or Group dialog box and add user to the list of 
assignees.

Edit Select the appropriate assignee in the list and click this 
button to view or modify the assignee of the task rule. 

Remove Select the appropriate assignee and click this button to 
remove the assignee from the list.

Remove All Click this button to remove all specified assignees from 
the list.
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Notify Task Rule

If you are creating a Notify Task Rule, the Notify tab displays on the New Rule Properties dialog box.

Figure 4-28 New Rule Properties Dialog Box—Notify Tab

On the Notify tab, specify the recipients of the notification that the task rule has executed. You can add 
individual recipients or include a notification recipient list.

Field Description

Add notification recipients Displays list of users to be notified by the task rule.

 • Add—Click this button to launch the Select 
Notification Recipient to Add dialog box to specify 
the recipients. 

On the dialog box, enter the email address for the 
recipient or click the Reference  tool to select the 
appropriate variable reference containing the recipient 
or list of recipients from the Insert Variable Reference 
dialog box and then click OK.

 • Edit—Select the appropriate recipient in the list and 
click this button to view or modify the recipient of the 
task rule. 

 • Remove—Select the appropriate recipient in the list 
and click this button to remove the recipient from the 
list.

 • Remove All—Click this button to remove all specified 
recipients from the list.

Add notification recipient list Click the Reference  tool to select the appropriate 
variable reference containing list of recipients from the 
Insert Variable Reference dialog box. 
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Update Task Rule

If you are creating an Update Task Rule, the Update tab displays on the New Rule Properties dialog box.

Figure 4-29 New Rule Properties Dialog Box—Update Tab

On the Update tab, specify the properties to be updated after the task rule has executed. 

Step 9 Click OK to save the task rule definition and close the dialog box.

Field Description

Add Click this button to add a new property to the Properties 
to update area.

Remove Click this button to remove the last property added to 
the Properties to update area.

Property From the Property drop-down list, choose the item to 
update within the task. The properties displayed depend 
on the selected item.

List action Choose the appropriate item from the drop-down list to 
determine which action to take with the selected 
property:

 • Add Item—Adds item to task.

 • Remove item—Removes item from task.

 • Clear—Removes property value from task.

Value Enter new value for the property.
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Managing Task Rule Definitions 
This section provides instructions on modifying task rules in the Definitions—Task Rule view. Only 
users with administrative rights can modify task rules in TEO.

Note For additional information on managing task rules, see the Tidal Enterprise Orchestrator Reference 
Guide.

Enabling a Task Rule 

A task rule is enabled by default. If a task rule is manually disabled, the task rule must be enabled before 
it is available for execution. 

On the Definitions—Task Rules view, select the task rule and then use one of the following methods to 
enable it:

 • On the Results pane, right-click and choose Enable. 

-or-

 • On the Details pane, select Click here to enable.

The Enabled column on the Results pane changes to True. If necessary, click the Refresh  tool to 
update the view.

Disabling a Task Rule

Disabling a task rule prevents the item from being available for execution. The disabled task rule is not 
removed from the list of task rules on the Definitions—Task Rules Results pane.

On the Definitions—Task Rule view, select the task rule and then use one of the following methods to 
disable it:

 • On the Results pane, right-click and choose Disable. 

-or-

 • On the Details pane, select Click here to disable.

The Enabled column on the results pane changes to False. If necessary, click the Refresh  tool to 
update the view.
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Creating a Copy of a Task Rule 

The copy option is used when the user wants to leverage an existing task rule to define a new task rule 
using existing properties. 

Step 1 On the Definitions—Task Rules view, select the appropriate task rule, right-click and choose Copy.

Step 2 On the Results pane, right-click and choose Paste.

A copy of the defined task rule is pasted onto the Results pane.

Step 3 To rename the copied task rule or other properties, right-click and choose Properties.

Step 4 Modify the task rule name, as appropriate, and click OK to close the dialog box.

Sorting Task Rules

The task rules are executed according to the order they are listed on the Definitions—Task Rules view. 
You should sort the task rules based on the order in which you want them to execute.

Note All task rules will execute even if there is more than one task rule assigned for the same condition. For 
example, if you have two assignment rules for the same incident, both rules will be executed in the order 
listed in the Task Rules view.

On the Definitions—Task Rules view, select the task rule and use one of the following methods to move 
it to the desired position in the list:

 • Drag and drop the task rule into the appropriate position in the list.

 • On the Actions toolbar, click Move Up or Move Down.

 • Click the Actions menu and choose Move Up or Move Down.

 • Right-click and choose Move Up or Move Down.

The list of task rules are sorted according to the selected action. 

Deleting a Task Rule

Use the Definitions—Task Rules view to delete task rules that are no longer used.

Step 1 On the Definitions—Task Rules view, select the task rule, right-click and choose Delete.

Step 2 On the Confirm Delete dialog box, click Yes to confirm the deletion. 
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Enabling Notification Based on Assignment Processes
If you want to have emails sent to whoever is assigned to a task but do not want to create notification 
task rules, you can enable the processes that ship with the Core automation pack that send emails based 
on assignment.

When these processes are enabled, the user or user group who was assigned to tasks will receive the 
email notification.

Step 1 In the Definitions workspace, click Processes.

Step 2 Click the Filter by link and choose Automation Pack > Core to filter for the processes that ship with 
the Core automation pack.

Step 3 Right-click the appropriate Notification Based on Assignment process and choose Enable.

The following processes are for notification based on assignment:

Process Name Description

Default Alert Notification Based on 
Assignment

Sends email when an alert gets assigned.

Default Approval Request Notification 
Based on Assignment

Sends email when an approval request gets assigned.

Default Change Request Notification 
Based on Assignment

Sends email when an change requests gets assigned.

Default Guided Operation Request 
Notification Based on Assignment

Sends email when a guide operation request gets assigned.

Default Incident Notification Based on 
Assignment

Sends email when an incident gets assigned.

Default Input Request Notification Based 
on Assignment

Sends email when an input request gets assigned.

Default Review Request Notification 
Based on Assignment

Send email when a review request gets assigned.
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Managing the Cloud Processes

This chapter provides information on using the product, specific to the Cloud automation packs. It 
includes information on accessing the Cloud processes and filtering for specific processes, managing the 
processes, starting a process, and viewing a running process, its results, and the automation summary 
generated by the process.

It includes the following sections:

 • Accessing Cloud Processes, page 5-2

 • Managing the Cloud Processes, page 5-4

 • Running Processes, page 5-10

 • Viewing Process Results, page 5-13

 • Viewing Automation Summary, page 5-15

Note Before you can run the Cloud processes, you must configure the objects that are referenced by the 
processes and activities. See Chapter 4, “Getting Started Using the Automation Pack” for information 
on configuring the Cloud-related objects in TEO.
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Accessing Cloud Processes
The processes that ship with the product can be accessed from the Definitions—Processes view.

Step 1 On the Console, select the Definitions workspace and click Processes in the navigation pane. By default, 
all the processes display in the Processes pane. 

Figure 5-1 Processes View

If you have multiple automation packs installed, you can filter the processes to display the processes 
specific to the automation pack.

Step 2 In the upper portion of the Processes pane, click the Filter by link and choose Automation Pack.

Step 3 In the drop-down list, choose [Automation Pack Name].

Figure 5-2 Filtering Processes by Automation Pack

The processes display in the Processes pane (see Figure 5-4 on page 5-5).
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Filtering Processes by Category
The Cloud automation packs contain categories by which you can also filter the processes. This is 
particularly useful when you are initializing your cloud environment and need to filter for Cloud 
Governor Operations processes.

Step 1 In the upper portion of the Processes pane, click the Filter by link and choose Category.

Step 2 In the drop-down list, choose the category.

Figure 5-3 Filtering Processes by Category

Step 3 Scroll to the process.
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Managing the Cloud Processes
This section provides information on managing the Cloud processes, including:

 • Enabling and disabling processes

 • Enabling and disabling the process archival feature

 • Modifying a process schedule

Enabling a Process
Some processes are disabled by default to reduce the load on the server or because they may require 
configuration to your specific environment before they can be used. They may also have been imported 
as disabled by checking the Disable all imported processes check box in the Automation Pack Import 
Wizard. The disabled processes must be enabled before they are available for execution.

Perform the following steps to enable a process.

Step 1 In the Processes view, navigate to the process that you want to enable (disabled processes appear 
dimmed).

Step 2 Use one of the following methods to enable the process:

 • Right-click the process and choose Enable from the submenu.

 • In the Process Editor, click the General tab and then check the Enabled check box. Click the Save 
 tool to save your changes to the process and close the Process Editor.

Disabling a Process
Disabling a process prevents the process from executing. You may want to disable some processes to 
reduce the load on your server or while you are modifying the process definition.

Perform the following steps to disable a process.

Step 1 In the Processes view, navigate to the process that you want to disable.

Step 2 Use one of the following methods to disable the process:

 • Right-click the process and choose Disable from the submenu.

 • In the Process Editor, click the General tab and then uncheck the Enabled check box. Click the 
Save  tool to save your changes to the process and close the Process Editor.
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Modifying Process Instance Archival
TEO provides an option in the process definition that allows you choose whether or not to archive 
process and activity execution in the TEOProcess database. Disabling the Archive completed instances 
option helps improve performance and minimize the size of the database. It is also useful when 
debugging the execution of processes.

Perform the following steps to enable or disable the archival feature.

Step 1 In the Processes view, navigate to the process you want to flag for archival.

Step 2 Right-click the process and choose Edit from the submenu.

Figure 5-4 Opening a Process to Edit Properties

Step 3 On the process Properties dialog box, click the Options tab.
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Figure 5-5 Process Properties—Options Tab

Step 4 On the Options tab, uncheck or check the Archive completed instances check box to disable or enable 
process instance archival. 

If the process is already flagged for archival and you no longer want to save the process instances for 
this process, uncheck the check box.

Step 5 Click the Save  tool to save your changes to the process and close the process Editor.

Modifying a Process Definition
To modify a process that ships with the automation pack, you must copy the process and then modify 
the process definition specific to your environment.

Copying a Process

Step 1 In the Processes pane, filter the processes to display the Cloud processes.

Step 2 Scroll to the process you want to modify, right-click and choose Copy.

Step 3 Right-click in a blank area on the Processes pane, and choose Paste. 

Step 4 On the Filter by link, click Name to locate the copied process.
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Editing Process Definition

Once you have copied the example process, you can open the process in the Process Editor and edit the 
process properties.

Step 1 In the Processes pane, navigate to the copied process, right-click and choose Edit.

Step 2 On the Process Properties dialog box, click the tab for the information that you want to customize for 
the process definition:

 • General—Enter a customized description for the process.

 • Options—Modify the display, execution and archival options for the process.

 • Target—Modify the target for the process. By default, the process is defined to execute on the target 
that is specified at start time.

 • Credentials—If you modify the target for the processes, use this tab to assign the appropriate 
runtime user account for the target.

 • Variables—The example processes ship with pre-defined variables. You can add, delete or modify 
the variables for the process.

 • Triggers—The example processes do not have triggers assigned. Use this tab to specify how or when 
the the process will execute.

 • Categories—The copied process will be assigned to the same categories as the original process. You 
can create a new category using this tab.

Step 3 Modify the existing process workflow, if necessary, by adding activities or redefining the activity inputs. 

Step 4 When you have completed your changes to the process, click the Save  tool to save your changes and 
close the Process Editor.

Modifying a Process Schedule
Many of the processes that ship with the automation packs are triggered by a schedule. You can modify 
when the process will be executed by disabling the existing schedule and then creating a new schedule 
for the process. You use the process Properties dialog box to modify the process schedule.

Perform the following steps to assign a new schedule to a process.

Step 1 In the Processes view, navigate to the process for which you want to modify.

Step 2 Right-click the process and choose Edit from the submenu (see Figure 5-4 on page 5-5).

Step 3 On the process Properties dialog box, click the Triggers tab.
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Figure 5-6 Process Properties—Triggers Tab

Step 4 On the Triggers tab, right-click the current Schedule and choose Disable from the submenu.

Step 5 Click New > Schedule to open the Schedule Properties dialog box to create a new schedule for this 
process.

Figure 5-7 Schedule Properties

Step 6 On the Schedule Properties dialog box, specify the criteria for the new schedule and click OK.
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Note For information on creating schedules, see “Managing Triggers” in the Tidal Enterprise 
Orchestrator Reference Guide.

The newly created schedule displays on the Triggers tab and is enabled.

Figure 5-8 Process Properties—Triggers Tab with Newly Created Schedule

Step 7 Click the Save  tool to save your changes to the process and close the process Editor.
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Running Processes
The processes that ship with the product will run based on the trigger that was defined in the process 
definition. For processes that are triggered by a schedule, you can also manually start a process at any 
time (adhoc). This section guides you through starting a process and viewing its progress as it runs.

Note You can only view a running process and the process instances for processes that have the Archive 
completed instances feature enabled. See Modifying Process Instance Archival, page 5-5 for information 
on enabling the archival feature on a specific process.

Starting a Process

Step 1 In the Processes view, right-click the process and choose Start Process from the submenu.

Figure 5-9 Starting a Process

The Confirm Start Process dialog box displays. 

Figure 5-10 Confirm Start Process

Step 2 On the Confirm Start Process dialog box, click OK to start the process.
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The Start Process Results dialog box displays. Proceed to Viewing Running Process, page 5-11.

Viewing Running Process
After starting the process, you can use the Process Viewer to view the process as it runs through each 
activity.

Note You can only view a running process and the process instances for processes that have the Archive 
completed instances feature enabled. See Modifying Process Instance Archival, page 5-5 for 
information on enabling the archival feature on a specific process.

Step 1 On the Start Process Results dialog box, right-click the process and choose Observe.

Figure 5-11 Start Process Results—Observe Submenu

The Process Viewer displays the process workflow.
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Figure 5-12 Process Viewer—Viewing Process Running

Step 2 View the process as it proceeds through the workflow. 

The activities within the process workflow will change to green as they complete (succeed). 

Step 3 When the process completes, close the Process Viewer and proceed to Viewing Process Results, 
page 5-13.
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Viewing Process Results
After a process completes, you can view the results in the Operations workspace. 

Note You can only view a running process and the process instances for processes that have the Archive 
completed instances feature enabled. See Modifying Process Instance Archival, page 5-5 for information 
on enabling the archival feature on a specific process.

Accessing Process View

Step 1 On the Operations workspace, expand expand Process Views in the navigation pane and click the view 
that represents how the process was executed (for example, click View Adhoc if the process was 
manually executed).

Step 2 Using the Filter by link, choose Category and then choose the Cloud Governor Operations from the 
drop-down list.

Step 3 Scroll to the process and select it.

Step 4 In the View Results pane, expand the process to view each activity in the process workflow.

Figure 5-13 Operations Workspace—Viewing Process Results

Step 5 Review the status of the process and each activity within the process to verify that it has succeeded.
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Viewing Tasks
When a process detects an issue that requires action, an alert is generated. If you have configured the 
product to send notifications to a specific person in your organization, that person will receive an email 
notification whenever an alert is generated. You can also view these alerts in the Task Views on the 
Operations workspace. 

Step 1 On the Operations workspace, expand Task Views in the navigation pane and click the appropriate view, 
for example, View User Interactions.

Step 2 In the View User Interactions pane (upper pane), choose View all tasks from the Task Assignee 
drop-down list to display the tasks in the View Results pane.

Figure 5-14 Viewing Tasks

Step 3 To view a specific alert, right-click the alert and choose Review.
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Figure 5-15 Task Review Submenu

The Review Request Report displays in your web browser.

Viewing Automation Summary
When alerts are generated, TEO delivers an online Automation Summary that details the analysis that 
was performed to identify a situation that may require action. It also shows relevant diagnostic and state 
information captured while performing the situation analysis, and provides a recommended resolution 
for the situation.

You can access the Automation Summary from the Tasks View on the Operations workspace.

Step 1 On the Operations workspace, expand Task Views in the navigation pane and click View Alerts.

Step 2 In the View Alerts pane, click the View all tasks radio button to display the alerts in the View Results 
pane.

Step 3 Right-click the alert and choose View Automation Summary.
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Figure 5-16 View Automation Summary Submenu

The Automation Summary displays in your web browser.

Figure 5-17 Automation Summary
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Using the Cloud Activities

The Cisco TEO Cloud automation packs provide additional activities for managing the Cloud 
environment. These are additional activities that display in the Process Editor toolbox after the user has 
imported the automation packs.

When defining an activity in the process workflow, the properties pane contains property pages that are 
specific to the selected activity. This chapter provides instructions for defining these activities, 
instructions for completing the property pages for each specific activity, and instructions on viewing the 
activity results.

It includes the following sections:

 • Cloud Activities, page 6-2

 • Defining an Activity, page 6-3

 • Defining the Create Service Target Activity, page 6-7

 • Defining the Delete Service Target Activity, page 6-8

 • Defining the Add Service Request Note Activity, page 6-10

 • Defining the Complete Service Request Activity, page 6-11

 • Defining the Update Service Request Parameter Activity, page 6-13
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Cloud Activities
The following table displays the activities that are provided by the Cloud automation packs.

Activity Description

Create Service Target Creates a new service target that represents a type of 
service.

See Defining the Create Service Target Activity, 
page 6-7.

Delete Service Target Deletes a service target using the target name or target 
ID.

See Defining the Delete Service Target Activity, 
page 6-8.

Add Service Request Note Add text to a newScale service request history. The text 
can include a TEO automation summary path.

See Defining the Add Service Request Note Activity, 
page 6-10.

Complete Service Request Mark a newScale service request as complete and 
optionally add a note to the service request history.

See Defining the Complete Service Request Activity, 
page 6-11.

Update Service Request Parameter Sets the value of a newScale agent parameter, such as 
the IP address.

See Defining the Update Service Request Parameter 
Activity, page 6-13.
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Defining an Activity
Use the following steps to define an activity in the Process Editor. The property pages that display 
depend on the activity. Refer to the appropriate section for instructions on completing the activity 
property pages.

Step 1 On the Toolbox pane, navigate to the appropriate section, click the activity and drag it onto the 
Workflow pane.

The Activity Properties dialog box displays.

Note The Required Field  icon displayed on a tab or page indicates that the field is required and is 
missing a value. 
 
Click the Reference  tool to select a defined variable or reference an object within the 
process. For additional information, see the Tidal Enterprise Orchestrator Reference Guide.

Step 2 On the General tab, enter the following information:

Step 3 Click the Activity-specific tab (typically, Inputs) and enter the required information. See the appropriate 
section in this chapter for instructions on completing the fields on the activity-specific tab.

Step 4 Click the Target tab to specify the process target. You can use the process target or override it and 
specify a different target for the specific activity.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.

Field Description

Execute on the process target Click this radio button to use the same target that was 
specified for the process.

Execute on activity target Click this radio button to indicate that the activity should 
execute against a target selected in an activity within the 
process. Choose the activity from the drop-down list.

Execute on this target Click this radio button and choose a specific target from 
the drop-down list.

 • To view the properties for the selected target, click the 
Properties  tool. 

 • To create a new target for this process, click New.
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Step 5 Click the Credentials tab to specify the runtime user whose credentials should be used for process 
execution:

Execute on this target reference Click this radio button and then click the Reference  
tool to select the target reference property on which to 
execute the activity.

On the Insert Variable Reference dialog box, expand 
Process > Target > Properties, select the appropriate 
target reference property, and click OK.

The selected target reference property displays in the text 
field.

Execute on the target selected by this 
algorithm

Click this radio button to execute the target selected by one 
of the target algorithms displayed in the drop-down menu.

Note The available algorithms that display depend on 
the selected activity. 

Execute on this target group Click this radio button to choose a target group from the 
drop-down list.

 • To view the properties for the selected target group, 
click the Properties  tool. 

 • To create a new target group for this process, click 
New.

Use the Choose a target using this algorithm drop-down 
list to choose the algorithm that will determine the target 
to execute from the eligible target group.

Note The available algorithms that display depend on 
the selected activity.

Field Description

Use target's default runtime user Click this radio button to use the default runtime user 
for the target that is specified in the activity.

Use Process runtime user Click this radio button to use the credentials for the 
runtime user that was specified for the process.

Override process runtime user Click this radio button to specify different credentials 
than what are used for the process. The selected 
runtime user overrides the runtime user that was 
specified for the process.

 • To view the properties for the selected runtime 
user, click the Properties  tool. 

 • To create a runtime user record for the process, 
click New. 

Field Description
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Step 6 Click the Knowledge Base tab to specify a knowledge base article for the activity. The following 
information displays:

Step 7 If the knowledge base article is not displayed by default, click the Browse  tool in the Knowledge 
Base field. 

Step 8 On the Select Knowledge Base dialog box, select the appropriate knowledge base article in the list and 
click OK.

Note Click New to create a new knowledge base article. For additional information on knowledge 
base articles, see the Tidal Enterprise Orchestrator Reference Guide.

Step 9 Click the Result Handlers tab to specify condition branches for the activity.

Step 10 Click the Save  tool to save the activity definition.

Field Description

Knowledge base Knowledge base article associated with the activity.

Summary Brief description of the issue.

Possible Cause Explanation of the condition that may be causing the issue.

Possible resolution List of actions that can be performed to attempt to resolve 
the issue.

Related information Additional information related to the issue.

Button Description

Add Adds a condition branch.

Remove Removes the condition branch from the activity.

Move Up Moves the condition up one position in the list of 
conditions.

Move Down Moves the condition down one position in the list of 
conditions.
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Viewing Activity Results
When an activity is executed, results are displayed in the Operations workspace activity instance view. 

Step 1 In the Operations workspace, expand the Activity Views folder and click the view that represents how 
the process was executed (for example, View Adhoc, if the process was manually executed). 

Step 2 In the View Results pane, expand the process, and double-click the activity instance or right-click and 
choose Observe.

Step 3 On the Process Viewer, ensure that Properties is enabled in the View menu, and then click the activity 
in the workflow to display the activity instance properties.

Step 4 On the General tab, view the State field to determine if the activity Succeeded or Failed.

Step 5 Click the Inputs tab to view the display-only properties of the activity.

Step 6 Click the Outputs tab to view the results of the activity.
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Defining the Create Service Target Activity
Use the Create Service Target activity to create a new service target that represents a type of service.

Step 1 On the Toolbox pane, click the Create Service Target activity and drag it onto the Workflow pane.

Figure 6-1 Create Service Target Properties—General Tab

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Figure 6-2 Create Service Target Properties—Inputs Tab

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Defining the Delete Service Target Activity
Use the Create Service Target activity to delete a service target using the target name or target ID.

Step 1 On the Toolbox pane, click the Delete Service Target activity and drag it onto the Workflow pane.

Figure 6-3 Delete Service Target Properties—General Tab

Field Description

Display Name Display name of the service target to be created.

Description Text description of the service target to be created.

Service Type The type of service represented by the new service target.

Organization The organization to which the newly created service target 
belongs.
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Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Figure 6-4 Delete Service Target Properties—Inputs Tab

Step 4 In the Target ID or Name text field, specify the target ID or the display name of the service target to be 
deleted.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Defining the Add Service Request Note Activity
Use the Add Service Request Note activity to to add text to a newScale service request history. The text 
can include a TEO automation summary path.

Step 1 On the Toolbox pane, click the Add Service Request Note activity and drag it onto the Workflow pane.

Figure 6-5 Add Service Request Note Properties—General Tab

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Figure 6-6 Add Service Request Note Properties—Inputs Tab

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
6-10
Cisco TEO—Process Automation Guide for Cloud

OL-25276-01



 

Chapter 6      Using the Cloud Activities
  Defining the Complete Service Request Activity
Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Defining the Complete Service Request Activity
Use the Complete Service Request activity to mark a newScale service request as complete and 
optionally add a note to the service request history.

Step 1 On the Toolbox pane, click the Complete Service Request activity and drag it onto the Workflow pane.

Figure 6-7 Complete Service Request Properties—General Tab

Field Description

newScale Channel-ID The channel ID assigned to a service request by 
newScale for communicating back information about 
the service request. Typically, this is passed with the 
original service request.

Note The note to be added to the service request.
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Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Figure 6-8 Complete Service Request Properties—Inputs Tab

Step 4 In the newScale channel-id text field, enter the channel-ID assigned by newScale to uniquely identify a 
request. Typically, this is passed with the original service request.

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Defining the Update Service Request Parameter Activity
Use the Update Service Request Parameter activity to set the value of a newScale agent parameter, such 
as IP address.

Step 1 On the Toolbox pane, click the Update Service Request Parameter activity and drag it onto the 
Workflow pane.

Figure 6-9 Update Service Request Parameter Properties—General Tab

Step 2 On the General tab, enter the following information:

Step 3 Click the Inputs tab. 

Field Description

Name Name of the activity.

Type Display only. Displays the type of activity.

Description Text description of the activity.
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Figure 6-10 Update Service Request Parameter Properties—Inputs Tab

Step 4 Specify the following information:

Step 5 Complete the appropriate information in the following tabs:

 • Target—Specify whether the defined process target should be used or overridden.

 • Credentials—Specify the runtime user whose credentials should be used for process execution.

 • Knowledge Base—Select the appropriate knowledge base article to associate with the activity.

 • Result Handlers—Click the appropriate buttons to manage the condition branches on the workflow.

Step 6 Click the Save  tool to save the activity definition.

Field Description

newScale channel-id The channel-ID assigned by newScale to uniquely identify 
a request. Typically, this is passed with the original service 
request.

Parameter Name The name of the parameter to be set in newScale.

Parameter Value The value of the parameter to be set in newScale.
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Cloud Operations

This appendix describes tasks you may need to perform on a daily or less frequent basis for efficient 
cloud operations. Each section describes actions to be taken based on the task you want to perform. The 
following tasks are included:

 • Recovering From Failed Service Request, page A-2

 • Onboarding an Organization, page A-3

 • Offboarding an Organization, page A-4

 • Updating an Organization, page A-4

 • Allocating IP Address Pool for Organization, page A-4

 • Deallocating IP Address Pool for Organization, page A-5

 • Identifying IP Address Pools with Limited IP Addresses, page A-5

 • Identifying Orphaned IP Addresses, page A-5

 • Publishing New VM Template for Service Request, page A-6

 • Removing VM Template, page A-7

 • Adding New UCS Blade for Physical Provisioning, page A-7

 • Removing UCS Blade from Cloud, page A-7

 • Adding New TSP Template for Bare Metal Provisioning, page A-7

 • Removing TSP Template from Cloud, page A-8
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Recovering From Failed Service Request

Evaluate the Failure
Perform the following tasks to evaluate the failure, including identifying the cause and possible 
resolutions:

 • Locate the incident created for the failed service request. Typically, these incidents have an incident 
class of 5001.

 • Review the incident description to understand the issue that caused the failure. The description may 
also include a URL to a related alert for a technical issue that may have caused the failure.

 • Review the knowledge base article that is included in the automation summary for the incident to 
identify a possible resolution for the failure.

Resolving Technical Issue
If the technical issue that is causing the failure can be resolved, perform the following tasks:

 • Add a note to the TEO change request for the service stating that the problem is being resolved and 
the service will be completed. The note will be synchronized to the newScale service request.

 • Resolve the technical issue causing the failure.

 • Manually execute the TEO processes identified in the knowledge base. The service target is 
identified in the incident description.

 • If the processes complete successfully, add a note to the TEO change request for the service stating 
that the service request has been fulfilled.

 • Update the status of the change request to Change Complete. This will also complete the newScale 
service request.

Cancelling Service Request
If the technical issue that is causing the failure cannot be resolved, perform the following tasks:

 • Add a note to the TEO change request for the service stating the problem cannot be resolved at this 
time and possibly resubmit the request at a later time. This note will be synchronized to the newScale 
service request.

 • Update the status of the change request to Canceled. This will also complete the newScale service 
request.

 • In the Processes view, filter by the Cloud Governor Operations category and execute the process 
“Release Service Target” to release all resources allocated to the service target.
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Releasing All Resources Allocated to Service Target
For a variety of reasons you may need to release all resources allocated for a service target. This will 
delete an associated VM, release reserved IP addresses, and release reserved physical resources.

In the Processes view, filter by the Cloud Governor Operations category and execute the process 
“Release Service Target” to release all resources for a selected service target.

Reviewing Configured Resources
The Cloud Governor Report is an automation summary that will show you the resources configured and 
allocated in the cloud. This information is useful in other operations, such as onboarding a new 
organization or allocating IP address pools. By default, the Cloud Governor Report is generated every 
morning at 6:00 a.m. You can also execute the Cloud Governor Report adhoc.

In the Processes view, filter by the Cloud Governor Operations category and execute the process “Cloud 
Governor Report” to review configured and allocated resources in the cloud.

When the process completes, a Review Request will be created and assigned to the person requesting the 
report. The Review Request can be viewed in Operations > Task Views > View User Interactions.

Onboarding an Organization
Before people in an organization can submit orders for services in the cloud, the organization must be 
defined in newScale and the Cloud Governor. This will configure the cloud resources available for the 
organization. Perform the following task to onboard an organization in the cloud:

 • Define the organization in newScale using the Organization Designer module.

 • Look up the organization ID assigned to the new organization. 

 – In newScale, order the Query Tenant Organization ID service.

 – Select the new organization from the drop-down list and note the assigned ID. 

Note It is NOT necessary to submit the order.

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the 
“Organization – Onboard” process.

Enter the values in the applicable parameters for the process. Review the description for each 
parameter for information about the value to be entered. You can find many of these parameter 
values in the Cloud Governor Report (see Reviewing Configured Resources, page A-3 for 
information on the Cloud Governor Report). 

Tip If several organizations will be onboarded with the same resources, create a parent process for 
the organization and call the “Organization – Onboard” process as a child process. Hard code 
the parameters that do not change, and create input variables for parameters that will change.
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Offboarding an Organization
When an organization is no longer valid, you need to remove the organization and release all cloud 
resources that are allocated to the organization. Perform the following tasks to offboard an organization 
from the cloud:

 • Review the Cloud Governor Report to identify the organization ID and the current resources 
allocated for the organization.

 • Release all service targets created by the organization (see Releasing All Resources Allocated to 
Service Target, page A-3).

 • Release all IP address pools allocated for the organization (see Deallocate an IP address pool for an 
organization).

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the 
“Organization – Offboard” process.

Updating an Organization
Occasionally, you may need to update the resources assigned to an organization, such as the TEO server 
that will own requests for an organization. Perform the following tasks to update an organization:

 • Review the organization on the Cloud Governor Report to view the current organization 
configuration (see Reviewing Configured Resources, page A-3).

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the 
“Organization – Onboard” process. 

Enter the values in the applicable parameters for the process. Review the description for each 
parameter for information about the value to be entered. You can copy the input parameters that do 
not change from the Cloud Governor Report, and then enter new values for the parameters that need 
to be updated.

Allocating IP Address Pool for Organization
For new organizations, you need to allocate public IP address pools or management IP address pools.  
Also, when an organization is depleting allocated IP addresses, you may need to allocate additional 
pools.

 • Review the organization on the Cloud Governor Report to identify the organization ID and current 
IP address pools allocated for the organization (see Reviewing Configured Resources, page A-3).

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute one or both 
of the following processes:

 – IP Address Pool – Allocate Public

 – IP Address Pool – Allocate Management
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Deallocating IP Address Pool for Organization
IP addresses for an organization need to be deallocated when they need to be made available for other 
organizations or when an organization is removed from the cloud.

 • Review the organization on the Cloud Governor Report to identify the organization ID and current 
IP address pools allocated for the organization (see Reviewing Configured Resources, page A-3).

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute one or both 
of the following processes:

 – IP Address Pool – Deallocate Public

 – IP Address Pool – Deallocate Management

Identifying IP Address Pools with Limited IP Addresses
It is important to identify IP address pools that are running short on available IP addresses before the 
pool is completely depleted, which will result in service request failures.

Review the IP Address Pool Analysis section in the Cloud Governor Report (see Reviewing Configured 
Resources, page A-3) to identify IP address pools that are running short on available IP addresses. The 
pools that are running short will be highlighted in yellow or red.

Identifying Orphaned IP Addresses
It is important to identify orphaned IP addresses and release them for use by other services.

 • Review the following sections in the Cloud Governor Report (see Reviewing Configured Resources, 
page A-3) to identify orphaned IP addresses:

 – Orphaned Management IP Addresses

 – Orphaned Public IP Addresses

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the 
“Release IP Address” process. In the Table Name parameter, use one of the following values:

 – PublicIPAddressInstance

 – ManagementIPAddressInstanc
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Publishing New VM Template for Service Request
VM templates allow requestors to request a virtual server based on a predefined template. When you 
create a new VM template, it must be added to newScale and the Cloud Governor so that it can be used 
to order a service. Perform the following tasks to publish a new VM template.

Define Template
You must first define the template in newScale. Perform the following tasks to define the template:

a. Select the Service Item Manager module and then select Manage Standards.

b. Add the template to one of the following standards tables in the TCO Provision Group:

 • TCO VM Application Server

 • TCO VM DB Server

 • TCO Web Server

c. Use the OS Type and OS Name values to group the templates into the correct service:

 • OS Type should be either Windows or Linux

 • OS Name is arbitrary but should be consistent. For example, “Windows Server 2008 64 bit” or 
“CentOS”

Add Template to Cloud Governor
You must now add the VM template to the Cloud Governor.

In the TEO, filter the processes by the Cloud Governor Operations category and execute the “VM 
Template – Add” process to add the template to the Cloud Governor. Use the following guidelines when 
entering the parameters for the process:

 • OS Type, OS Name and Application Name parameters need to match what was entered in the 
newScale standards table.

 • The Application Type parameter depends on which newScale standards table you entered in the 
template:

 – TCO VM Application Server = Application Server

 – TCO VM DB Server = Database Server

 – TCO Web Server = Web Server

 • The Template Folder is the complete path in VMware vCenter where the template is located.
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Removing VM Template
When a template is no longer available for ordering as a service, it needs to be removed from the Cloud 
Governor. Perform the following tasks to remove a VM template from the cloud to prevent it from being 
ordered as a service:

 • Review the Cloud Governor Report (see Reviewing Configured Resources, page A-3) to identify the 
current configured VM templates.

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the “VM 
Template – Delete” process to remove the template. Use the report to obtain the parameter values 
to run the process.

Adding New UCS Blade for Physical Provisioning
When a new Cisco UCS blade is made available for physical server provisioning, it needs to be added 
to the Cloud Governor. Perform the following tasks to add a new Cisco UCS blade:

 • Review the Cloud Governor Report (see Reviewing Configured Resources, page A-3) to identify the 
physical servers defined in the cloud.

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the 
“Physical Server – Add” process. 

Removing UCS Blade from Cloud
When a Cisco UCS blade is no longer available for physical server provisioning, it needs to be removed 
from the Cloud Governor. Perform the following tasks to remove the UCS blade:

 • Review the Cloud Governor Report (see Reviewing Configured Resources, page A-3) to identify the 
physical servers defined in the cloud.

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the 
“Physical Server – Delete” process. 

Adding New TSP Template for Bare Metal Provisioning
When a new TSP template is made available for bare metal server provisioning it needs to be added to 
the Cloud Governor. Perform the following tasks to add a new TSP template:

 • Review the Cloud Governor Report (see Reviewing Configured Resources, page A-3) to identify the 
TSP templates defined in the cloud.

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the “TSP 
Template – Add” process. 
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Removing TSP Template from Cloud
When a new TSP template is no longer available for bare metal server provisioning, it needs to be 
removed from the Cloud Governor. Perform the following tasks to remove a TSP template:

 • Review the Cloud Governor Report (see Reviewing Configured Resources, page A-3) to identify the 
TSP templates defined in the Cloud Governor.

 • In the TEO, filter the processes by the Cloud Governor Operations category and execute the “TSP 
Template – Delete” process. 
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